## Contents

### Preface
- Intended Audience ix
- Documentation Accessibility ix
- Related Documents x
- Conventions x

### What's New
- New Features for Release 10.1.3.1.0 xi

### 1 Getting Started
- Overview of Active Studio 1-1
- Active Studio Interface 1-1
  - Accessing Active Studio 1-2
  - Tabs 1-3
  - Toolbars 1-3
  - Reports 1-3
  - Alerts 1-3
  - Folders 1-3
  - Actions 1-3
  - View Tasks/Options 1-3
  - Guide Text 1-4
  - View Editor 1-4
  - Personalizing Active Studio 1-5
- Report Creation and Delivery 1-5
- Features and Components 1-5
  - Features 1-5
  - Components 1-6
- Internet Explorer Settings 1-6

### 2 Using Reports
- Working with Reports 2-1
- Viewing Reports 2-1
  - Prompts 2-2
  - Active Data 2-3
- Creating Tiled Reports 2-3
3 Using Views

Using List Views ....................................................................................................................... 3-1

Creating List Views ..................................................................................................................... 3-2

List View Formatting Properties .................................................................................................. 3-2

Sorting Data in List Views ............................................................................................................. 3-3

Adding Summaries to a Collapsed List .......................................................................................... 3-3

Using the Action List ...................................................................................................................... 3-4

Selecting Rows of Data in the Action List ..................................................................................... 3-4

Editing Data in the Action List ....................................................................................................... 3-4

Adding Action Buttons .................................................................................................................. 3-4

Using Chart Views ......................................................................................................................... 3-4

Creating Chart Views ...................................................................................................................... 3-5

Chart View Formatting Properties ................................................................................................. 3-6

Using the Pie Chart ....................................................................................................................... 3-7

Creating Statistical Process Control Charts .................................................................................. 3-7

Creating an SPC Chart Data Object ............................................................................................... 3-8

Selecting Fields for SPC Charts .................................................................................................... 3-8

Configuring Time Groups .............................................................................................................. 3-9

Creating Charts With Multiple Data Objects ................................................................................. 3-10

Adding Data Objects to Chart Views ............................................................................................. 3-10

Editing Charts Containing Multiple Data Objects .......................................................................... 3-10

Removing Data Objects From Charts ........................................................................................... 3-10

Using the Columnar View ............................................................................................................. 3-10

Adding Summaries to a Columnar View ......................................................................................... 3-11

Columnar View Formatting Properties ......................................................................................... 3-11
4 Formatting Views

Formatting Views ........................................................................................................... 4-1

Applying Data Modifiers ................................................................................................. 4-1

Filtering Data ................................................................................................................ 4-1

Using Active Now ............................................................................................................ 4-4

Displaying Top N Data .................................................................................................... 4-4

Using Drilling .................................................................................................................. 4-5
Drilling Down .................................................................................................................. 4-5
Drilling Up ...................................................................................................................... 4-6
Drilling Through ............................................................................................................... 4-6
Drilling Across ............................................................................................................... 4-6
Adding Drilling Hierarchies to Views ........................................................................ 4-6
Enabling Drilling Through to Details .......................................................................... 4-7
Configuring Drill-Across Targets ................................................................................ 4-7
Drilling Across to a URL ............................................................................................... 4-8
Adding Calculations ..................................................................................................... 4-9
Using Expressions in Calculated Fields ...................................................................... 4-10
Using Special Characters in Calculated Fields .......................................................... 4-18
Using HTML in Calculations ...................................................................................... 4-18
Adding Surface Prompts ............................................................................................ 4-19

Formatting View Properties ....................................................................................... 4-19
Formatting General Properties ................................................................................... 4-19
Formatting Axis Properties ........................................................................................ 4-20
Formatting Borders and Shading ............................................................................... 4-20
Formatting Text Alignment ......................................................................................... 4-21
Displaying Data Labels ............................................................................................... 4-22
Formatting Fonts .......................................................................................................... 4-22
Formatting Themes ....................................................................................................... 4-22
  Adding and Changing Themes .................................................................................. 4-23
Formatting Values ........................................................................................................ 4-23
Formatting the Display of Active Data ...................................................................... 4-24

5 Editing Columnar Reports
About Columnar Reports ............................................................................................ 5-1
Using Formatting Toolbars ......................................................................................... 5-1
Inserting Images .......................................................................................................... 5-2
Inserting Text ................................................................................................................ 5-3

6 Using Alerts
Introducing Alerts ........................................................................................................ 6-1
Building Alert Rules .................................................................................................... 6-1
Using Alert Rule Options ............................................................................................. 6-2
Creating Alert Rules From Templates ....................................................................... 6-4
Creating Alert Rules With Messages .......................................................................... 6-4
Creating Complex Alerts ......................................................................................... 6-5
Modifying Rules for Alerts ....................................................................................... 6-6
Viewing Alert History ................................................................................................. 6-6
Clearing Alert History ............................................................................................... 6-6
Activating Alerts .......................................................................................................... 6-6
Launching Alerts by URL ............................................................................................ 6-7
Deleting Alerts ............................................................................................................ 6-7
Parameterized Alerts ................................................................................................. 6-7
7 Using Prompts and Parameters

About Prompts and Parameters ........................................................................................................  7-1
Creating Parameters ..........................................................................................................................  7-1
Creating Custom Parameters ............................................................................................................  7-2
Creating Prompts ..............................................................................................................................  7-2
Working with Prompts and Parameters ............................................................................................  7-4
  Creating Prompts and Parameters .................................................................................................  7-4
  Arranging Prompt Order ..................................................................................................................  7-4
  Previewing Prompts ........................................................................................................................  7-5
  Editing Prompts and Parameters .....................................................................................................  7-5
  Deleting Prompts and Parameters ..................................................................................................  7-5
  Cascading Prompts ........................................................................................................................  7-5
Using Parameters in Report URLs .....................................................................................................  7-6
Driving Prompts and Parameters from Other Views ..........................................................................  7-6
  Configuring Driving .......................................................................................................................  7-7
  A Driving Example ..........................................................................................................................  7-7

8 Using Action Buttons

About Action Buttons ..........................................................................................................................  8-1
Creating Action Buttons .....................................................................................................................  8-1
  Creating Action Buttons ..................................................................................................................  8-1
  Configuring Insert Action Types .....................................................................................................  8-3
  Configuring Constant Value Update Action Types ........................................................................  8-4
  Configuring Edit Column Update Action Types .............................................................................  8-5
  Configuring Delete Action Types ..................................................................................................  8-5
  Configuring Open a URL Action Types .........................................................................................  8-5
  Configuring View a Report Action Types .......................................................................................  8-6
  Configuring Reset a Form Action Types .........................................................................................  8-7
  Configuring Refresh a View Action Types ......................................................................................  8-8
  Configuring Show a Confirmation Message Action Types ............................................................  8-8

9 Organizing and Sharing Reports

Organizing Your Reports ....................................................................................................................  9-1
Creating New Folders .........................................................................................................................  9-1
Setting Folder Permissions ................................................................................................................  9-2
Working with Folders .........................................................................................................................  9-3
Copying Reports and Folders ............................................................................................................  9-3
Moving Reports and Folders ..............................................................................................................  9-4
Sharing Reports with Other Users .....................................................................................................  9-4
Deleting Shared Reports ....................................................................................................................  9-4

10 Personalizing Your Active Studio Settings

Specifying Report Loading Indicator Settings .................................................................................. 10-1
Specifying Printing Options .............................................................................................................. 10-1
Specifying Alert Delivery Settings .................................................................................................. 10-2
This preface explains how to use this book. It contains the following topics:

- **Intended Audience**
- **Documentation Accessibility**
- **Related Documents**
- **Conventions**

**Intended Audience**

This manual is intended for report creators responsible for creating reports in Oracle Business Activity Monitoring. Using the Administrator application, the report creator creates private and shared reports, and creates alerts triggered on events in those reports.

**Documentation Accessibility**

Our goal is to make Oracle products, services, and supporting documentation accessible, with good usability, to the disabled community. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at

http://www.oracle.com/accessibility/

**Accessibility of Code Examples in Documentation**

Screen readers may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.

**Accessibility of Links to External Web Sites in Documentation**

This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.
TTY Access to Oracle Support Services
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398.

Related Documents
For more information, see the following manuals in the Oracle Business Activity Monitoring Release 10g documentation set:

- Oracle Business Activity Monitoring Installation Guide
- Oracle Business Activity Monitoring Administrator’s Guide
- Oracle Business Activity Monitoring Architect User’s Guide

Conventions
The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td>italic</td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>
What's New

This section contains information about the new features in release 10.1.3.1.0.

New Features for Release 10.1.3.1.0

Release 10.1.3.1.0 includes the following new features:

- **Sensor integration with BPEL**
  You can create sensor actions in Oracle BPEL Process Manager to publish sensor data as data objects on an Oracle Business Activity Monitoring Server. See the Oracle BPEL Process Manager Developer’s Guide for more information.

- **HTML calculations in List views**
  You can add HTML tags to calculated fields in a report in order to add special formatting to the field. See the Oracle Business Activity Monitoring Active Studio User’s Guide for more information.

- **National Language Support in Active Viewer**
  Active Viewer will display the appropriate language and numeric formats that correspond with the system on which it is installed. See the Oracle Business Activity Monitoring Installation Guide for more information.

- **Streamlined install process**
  Oracle Business Activity Monitoring just got easier to install. The InstallShield wizard guides you through each step and installs any dependencies needed on your host. See the Oracle Business Activity Monitoring Installation Guide for more information.
This chapter introduces the Oracle Business Activity Monitoring Active Studio application.

This chapter contains the following topics:

- Overview of Active Studio
- Active Studio Interface
- Report Creation and Delivery
- Features and Components
- Internet Explorer Settings

**Overview of Active Studio**

The Oracle Business Activity Monitoring Active Studio application is a robust web-based tool for creating and delivering reports. Once created, reports can be viewed in Active Viewer. From Active Studio, power users share reports with other users and create alert rules for report delivery. Reports are either real-time reports, with live data updating on screen, or point-in-time (snapshot) reports.

Creating reports includes actions such as data object and field selection, formatting, filtering, and summaries. Reports can be shared with other users and alert rules can be created for determining the scheduling and delivery of the reports. Report types include charts, lists, key performance indicators (KPIs), crosstabs, spreadsheets, and more.

**Active Studio Interface**

This section helps you become familiar with Active Studio terms and user interface elements. It contains the following topics:

- Accessing Active Studio
- Tabs
- Toolbars
- Reports
- Alerts
- Folders
- Actions
Accessing Active Studio

Always use the start page to start Web applications. Do not start Web applications from a direct URL to the application. This ensures that caching works correctly. Also, do not use localhost in the URL instead of the host name.

To access Active Studio:

1. In Microsoft Internet Explorer, go to http://<host>:<http_port>/oraclebam, where host is the name of the server where Oracle Business Activity Monitoring is installed.
   
   The Start Page opens.

2. Click Active Studio.
   
   Active Studio launches in a new browser window.
Tabs

Use the tabs at the top of the screen to navigate to different areas in Active Studio.

- **Home** is your starting point to view most recently used reports and reports recently shared with you.
- **My Reports** is where you save reports you create and own.
- **Shared Reports** contains reports created by other Active Studio users that they have shared with you.
- **Alerts** is for creating new alert rules and viewing alert history. You can also change alerts from being active to inactive to temporarily disable them.

Toolbars

The toolbars shown on each tab of the Active Studio interface change to indicate what actions you can take. Not all actions have toolbar buttons.

![Figure 1–2  Edit Report Toolbar](image)

Reports

Reports display single or multiple views. Each view in a report can be a different type and contain different data. When creating reports, you can choose a tiled template containing a combination of views, a single view, or a continuous Columnar report. Continuous Columnar reports contain the single Columnar view and provide more formatting features for this type of report. See Chapter 2, "Using Reports" for more information.

Alerts

Alerts are launched by alert rules that you can create and manage from the Alerts tab. See Chapter 6, "Using Alerts" for more information.

Folders

Create folders to organize, manage, and share your reports. Set permissions on folders in the Shared Reports tab to grant access to other users. See Chapter 9, "Organizing and Sharing Reports" for more information.

Actions

Actions are tasks you can do with reports and alerts. Examples of actions include creating, viewing, and editing reports and alerts. Actions in the Actions list change depending on if you are editing reports or working with alerts.
Figure 1–3 Actions List

View
Save Report
Save Report As
Close
Change Report Properties
Go to Edit Shortcut
Select Change Data Source

Clicking the arrow in the upper right corner of the Actions list collapses the list.

View Tasks/Options

The View Tasks/Options presents tasks and options for views. Clicking the arrow in the upper right corner of the View Tasks/Options list collapses the list.

Figure 1–4 View Tasks/Options List

View Tasks/Options
Edit view
Choose view type

Guide Text

The Guide text provides tips as you use Active Studio. Clicking the arrow in the upper right corner of the Guide box collapses it.

Figure 1–5 Guide Text

Guide
To create a report, choose a report layout, and select a view, a data object, fields, and formatting options. After clicking the Finish button, you can view your report and save it. Continue editing your report by double-clicking the report display.

View Editor

The View Editor contains a set of tabs to select data and data modifiers and format the views in your reports. When you create reports, the View Editor provides a wizard format to lead you through the steps. When you edit views, you can click the tabs for the formatting or data functions you want to change.

Figure 1–6 View Editor
Personalizing Active Studio

Personalize your Home tab display, print settings, and alert delivery settings. See Chapter 10, "Personalizing Your Active Studio Settings" for more information.

Report Creation and Delivery

You create reports in Active Studio for viewing, sharing with other users, and for delivery by alerts based on information or conditions changing. Reports contain one or more views of active or static data. Each view is formatted to show information from a data object in a view type such as a list, chart, or KPI.

You can share reports with other Active Studio users by creating folders containing reports in the Shared Reports page. Assign permissions to allow users to view, create, or delete reports in a particular folder. Create alert rules to automate report delivery to users. Alert rules can include conditions to launch the alert when data in a report changes, when its a certain time, or when other events occur. You can deliver reports through alerts to users by email.

The information displayed in a report is from data currently in the data object used in the report. Data objects are created in Architect and stored in the Active Data Cache. The data designer manages data objects using Architect. The Architect creates Enterprise Message Sources and manages Plans to load data into data objects.

Access to applications, permissions to create reports, alert rules, and data objects, and other user information is managed from the Administrator application.

Features and Components

This section describes Oracle Business Activity Monitoring features and components.

Features

Oracle Business Activity Monitoring includes the following features:

**Active Data Architecture.** Oracle Business Activity Monitoring provides an active data architecture that dynamically moves real-time data to end users through every step of the process. This solution actively collects data, applies rules designed to monitor changes, and delivers the information in reports to users.

**Real-time Reports.** Real-time reports containing current data are delivered as soon as data changes occur. This is possible because of data in the Active Data Cache and the connections to real-time transactional feeds.

**Active Presentations in Reports.** Reports display active data presentations where data continuously updates, formats, and displays. When data changes, the display changes in real-time.

**Instant Alerts.** Alerts, based on rules and events occurring in real-time, are delivered through email.

**Rules-Based Active Delivery.** In an event-driven solution, the information finds the target users instead of requiring users to query for the information on their own initiative. The reports are initially designed for delivery to end users based on data changing or events triggering. For the end user, the result is zero-click reporting that is always relevant.

**High Performance, Scalable Architecture.** Oracle Business Activity Monitoring is scalable to handle large amounts of complex, real-time enterprise data. Enterprise Link uses data flow technology to select the correct raw data and then transform and
perform calculations required by the data designer. The transformed data is delivered to the Active Data Cache in a ready-to-use state for fast access.

Components

Oracle Business Activity Monitoring includes the following architectural components and applications:

**Active Data Cache** is designed and optimized to handle large amounts of data in a real-time solution. To make data readily accessible and deliverable, it maintains real-time views of the data. The data feed to the Active Data Cache is a combination of business data sources, from data warehouse information to transactional feeds and other enterprise sources. Enterprise Link sends this information to the Active Data Cache in a continuous stream as data changes occur.

**Enterprise Link** connects Oracle Business Activity Monitoring to real-time data with message queues and also to other information sources such as database servers, flat files, and XML sources.

**Event Engine** monitors complex data conditions and implements specified rules. Rules can include a series of conditions and actions attached to an event. The Event Engine continuously monitors the information in the Active Data Cache for certain conditions and executes the related actions defined in associated rules.

**Report Engine** applies the report definitions to the data sets retrieved from the Active Data Cache for presentation in a browser. It manages information paging for viewing and printing reports. After reports are created, they are stored in the Active Data Cache so that report creation is not repeated each time. Most reporting views are designed to support live, active displays of data changing in real-time.

**Active Viewer** is the thin user interface for viewing reports. Active Messenger is client-side notification software. When new information is available, the user receives an email that contains a link to the information. The user clicks the link and the report is displayed in Active Viewer. Report formats include charts, lists, KPIs, crosstabs, spreadsheets, and more.

**Active Studio** is the thin user interface for the power user. Through Active Studio, the power user can create and edit reports. Reports can be shared with other users and rules can be created for determining the scheduling and delivery of the reports. Report types include charts, lists, KPIs, crosstabs, spreadsheets, and more.

**Architect** is the thin user interface for the data designer. Through Architect, the data designer creates and manages data objects in the Active Data Cache and manages real-time message processing.

**Administrator** is the thin user interface for the system administrator who is responsible for user management and overall server management. Using Administrator, the system administrator manages users and security levels, monitors loading to the Active Data Cache, and configures Oracle Business Activity Monitoring services.

Internet Explorer Settings

The following settings are recommended for your Internet Explorer browser.

Popup blockers should be disabled when using Active Studio.

As a default behavior of Internet Explorer, if the browser is displaying a web page, and you click a link in an email or an alert, the new page displays in the most recently used
browser window. You can change this behavior so that a new browser window opens each time a link outside of the current browser is clicked.

It is recommended to change this setting if you often have browsers open that you want to maintain when you click links in emails or alerts.

To change the setting to open a new browser for links in alerts or emails:

1. In Internet Explorer, select **Tools > Internet Options**.
2. Click the **Advanced** tab.
3. In the Browsing settings, make sure that the **Reuse windows for launching shortcuts** checkbox is deselected.
4. Click **OK**.

Better quality printing results if the **Print background colors and images** option is selected, which is not a default setting. This setting provides increased quality printing, especially for Crosstab views.

To change the setting for printing backgrounds:

1. In Internet Explorer, select **Tools > Internet Options**.
2. Click the **Advanced** tab.
3. In the Printing settings, select the **Print background colors and images** checkbox.
4. Click **OK**.

To make sure that new files are always viewed, set the Internet Explorer option to automatically check for updated files.

To change the cached files setting:

1. In Internet Explorer, select **Tools > Internet Options**.
2. On the General tab, click **Settings**.
3. Select **Automatically**.
4. Click **OK**.
This chapter introduces reports and how to work with them. This chapter contains the following topics:

- Working with Reports
- Viewing Reports
- Creating Tiled Reports
- Creating Columnar Reports
- Saving Reports
- Renaming Reports
- Editing Reports
- Printing Reports
- Copying Report URLs
- E-mailing Reports
- Saving Reports Offline
- Deleting Reports

**Working with Reports**

You can create reports and share them with other users. When designing reports, you can choose from a variety of template layouts. You might want to include two or more views in a single report. Creating reports also includes selecting data sources, choosing data fields, sorting, filtering, and formatting the information. Reports can display point-in-time or real-time information. Real-time information means the display continues to update within two to 10 seconds of data changing.

After creating reports, you can create alert rules that monitor data related to specific reports and send alerts to users. Alerts sent to Active Viewer users launch the view of the report for them.

**Viewing Reports**

This section contains the following topics:

- Prompts
- Active Data
You can view reports from the Home, My Reports, or Shared Reports tabs. You can specify whether to display an indicator as the report information loads.

To view a report on the Home tab:
Click the name of the report in the Recent list or the New list.
The report displays in the work space.

To view a report from the My Reports or Shared Reports tabs:
1. Click the name of the tab where the report is saved, for example, the My Reports tab.
2. Click the report to view.
3. Click View in the Actions list.
The report displays in the work space.

To close the report, either click Close in the Actions list or click another tab.

On the My Reports and Shared Reports tabs, you can sort the report lists by clicking Report Name, Last Modified, or Owner headings.

Prompts

Reports that include prompts display a dialog that requires user input before the results can display in the report.

If a prompt dialog displays, specify values for the prompts, and click OK. The report displays using the values you specified in the prompts.

Figure 2–1 Prompt Dialog

You can click the Reprompt button in the toolbar to view the dialog again and present different report results.
Active Data

When viewing reports, you can pause the display of active data in reports. For reports that are quickly updating, you might want to pause the display to view the current data before more active data is loaded.

To stop the display of active data:
- In a report you are viewing, click **Pause** in the toolbar.

The active data is temporarily halted, and the Pause button turns into a Play button.

To restart the display of active data:
- Click **Play** in the toolbar.

The active data displays, and the Play button turns back into a Pause button.

Creating Tiled Reports

You create reports from either the Home, My Reports, or Shared Reports tabs. The following is a summary of how to create reports:

1. Click **Create a New Report**. This button appears on the Home, My Reports, or Shared Reports tabs. The **Create a new report** toolbar icon also creates a new report.

2. Choose a report template. Tiled report templates include layouts for a single view or multiple views. A columnar report template is a continuous report view over several pages and has specific formatting options.

3. Choose a view type for each space in the template. View types include streaming lists, updating lists, bar charts, line charts, area charts, combination charts, columnar reports, KPIs, crosstabs, and spreadsheets.

4. Choose a data object. The View Editor walks you through selecting a data object, fields, and other options in a wizard format.

5. Define formatting properties for the view. Depending on the view type you select, formatting options vary. For example, for lists, you can format text and background colors, but for arrows you only select fields for the arrow layout since there is no text to format.

To create a report:

1. Click **Create a New Report**.

   The layout templates display. Tiled templates provide a layout for multiple views on one page.

2. Select a template. Select a tiled layout or select the Columnar Report template to create a multiple-paged, continuous format columnar report.

   A group of view types displays in each of the template areas. View types include charts, lists, KPIs, crosstabs, and spreadsheets.

3. Select a view type.

   A placeholder image of the view and the View Editor display. Depending on your data, this can take a few moments.
4. Select a data object. The data object is the source of data for the report. Data objects are created using Architect and are organized into folders by the Architect user.

5. Click Next.

6. Depending on the view you selected, select fields by doing one of the following:
   - Choosing Fields for Lists
     For list views, select the field checkboxes to include fields. Click select none to clear all of the checkboxes. The link switches to select all so you can select all of the fields again. If the data object contains 10 or fewer fields, the fields are automatically selected in the Data Fields list. If more than 10, you must manually select fields.
   - Choosing Fields for Charts
     For chart views, click the field checkboxes in the Group By list. If a field, for example Year, is a number, but you want to group on it, click Include Value Fields so that it displays in the Group By list. In the Chart Values list, select the checkboxes for value fields to display in the chart.
   - Choosing Fields for KPIs
     For KPI views, such as the arrow and gauges, select a field from each list where you want to display data. You are not required to choose a field for every drop down list.

   See Chapter 3, "Using Views" for more information on creating and formatting views.

7. Click Next.

   The list of additional options displays. You can click one of the links to add data modifiers or formatting properties.

8. Click Finish to display the view.

Additional tasks to finish a new report include formatting data, repeating the steps in this procedure for templates with multiple views, and saving reports.

Creating Columnar Reports

This section contains the following topics:

- Grouping Items
- Adding Summary Functions
- Quick Formatting in Columnar Reports

Creating a columnar report includes different characteristics than a tiled report. A tiled report contains views of data on a single page. A columnar report creates a multiple-paged, continuous formatted report. When you select the Columnar Report template, the columnar report view is also automatically selected. You can also select a tiled report template and a columnar report view although multiple pages are not provided for printing.

The following is a summary of how to create reports:

1. Choose the Columnar Report template. Tiled report templates include layouts for a single view or multiple views. A columnar report template is a continuous report view over several pages and has specific formatting options.
2. Choose a data object. The View Editor walks you through selecting a data object, fields, and other options in a wizard format.

3. Add Groups.

4. Add Summary Functions.

5. Define formatting properties for the view. Columnar report views include text formatting with additional options related to columnar reports.

To create a columnar report:

1. Click Create a New Report.

2. Select the Columnar Report template.

   The columnar report view type is automatically selected when you click the Columnar Report template.

   A placeholder image of the columnar report and the View Editor displays. Depending on your data, this can take a few moments.

3. Select a data object. The data object defines the source of data for the report. Data objects are created using Architect.

4. Click Next.

5. Select the data fields to include. Click select none if you do not want to select any fields. The link switches to select all so you can select all fields again. If the data object contains 10 or fewer fields, the fields are automatically selected in the Data Fields list. If more than 10, you must manually select fields.

6. Click Next.

   The Group dialog displays.

7. Select fields for grouping, and click Next.

   The Summary dialog displays.

8. Select fields for summary functions, and click Next.

   The More Options list displays. You can click one of the links to add a filter, a calculated field, or change formatting properties.

9. Click Finish.

   Additional tasks to finish a new report include formatting data, repeating the steps in this procedure for templates with multiple views, and saving reports.

**Grouping Items**

In a columnar report, you can group items, apply sorting, and add headers and footers from the Group tab.

To group items in a report:

1. Click the Data icon in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.

2. Select the Group tab.

3. Select a field in the Report Fields list. You can select more than one field to move multiple fields at the same time.

4. Click the Right arrow to move the field to the Report Groups list.
5. Select either **Header**, **Footer**, or **Detail** from the list for each field. At least one field must have Detail selected.

6. Select the **Ascending** or **Descending** sort direction if you want to change the sort direction for each field.

7. Select a field and click the Up arrow to move the field higher in the list, and click the Down arrow to move the field lower in the list.

8. For each field in the Report Groups list, specify whether you want it to display as a group header or a group footer or both by selecting the checkboxes.

9. Click **Apply** or **OK**.

### Adding Summary Functions

In a columnar report, you can add summary functions as report footers or group footers from the Summary tab.

To add summary functions in a report:

1. Click the **Data** icon in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.

2. Select the **Summary** tab.

3. Click a field in the **Report Fields** list.

4. Click one or more summary function checkboxes in the **Summary Functions** list.

5. Click the checkboxes to display the summary function in the report or group footers.

   Group footer options only display if you created groups on the Group tab.

6. Click **Apply** or **OK**.

### Quick Formatting in Columnar Reports

You can use the toolbar to apply grouping, sorting, and summarizing on single columns in columnar reports without opening the View Editor.

To apply quick formatting to a single column:

1. In the columnar report you are editing, click a column to select it.

   The column border is highlighted.

2. Click a button on the toolbar to apply a function to the column.

   The button functions include:

   - **Group Sort and Value Suppress** sorts by group and suppresses duplicate values from displaying.
   - **Value Suppress** suppresses duplicate values from displaying more than once.
   - **Sort Ascending** sorts the column in ascending order.
   - **Sort Descending** sorts the column in descending order.
   - **Group** adds a group header and footer for the column.
   - **Aggregate** adds a Sum group footer and report footer for the column.

3. You can undo these functions or further edit the columnar report by clicking **Edit view** and then clicking the Data button in the View Editor.
Saving Reports

To save a new report you created:

1. Click **Save Report** in the Actions list.
   The Save Report dialog displays.
2. Enter a unique name for the report or accept the default name, select the folder to save the report in, and click **OK**.
   You can click **Create a new folder** in the Save Report dialog to create a folder before saving the report.
   A dialog displays to confirm that the report is saved.
3. Click **OK** to close the dialog and return to the report.

To save a report you edited:

1. Click **Save Report** in the Actions list.
   A dialog displays to confirm that the report is saved.
2. Click **OK** to close the dialog and return to the report.

To save a report you edited as a new report:

1. Click **Save Report As** in the Actions list.
   The Save Report dialog displays.
2. Type a unique name for the report or accept the default name, select the folder to save the report in, and click **OK**.
   A dialog displays to confirm that the report is saved.
3. Click **OK** to close the dialog and return to the report.

To save a report for offline viewing:

1. Open a report for viewing.
2. Select **Save Offline** in the Actions list.
   The File Download dialog opens.
3. Click **Save**.
4. Choose a location in which to save the report.
5. Click **Save**.

**Note:** When printing a tiled report that has been saved offline, only the visible data will print. Data that is part of multipage views, as in List views, that is not currently displayed, is not printed. The exception to this is the Continuous mode Columnar report.

Renaming Reports

To rename a report:

1. Select the report to rename.
2. Click **Rename** in the Actions list.
   The Rename dialog displays.
3. Type the new name for the report.

4. Click OK.

   The new name displays as the report name.

**Editing Reports**

This section contains the following topics:

- Adding Report Titles
- Formatting Report Titles
- Setting Backgrounds for Reports
- Resizing Views
- Inserting Views
- Deleting Views
- Changing View Types
- Switching Data Objects
- Setting Active Data Retrieval Interval

You can edit any reports that you own. You can edit formatting options for each view, and you can change view types. You cannot edit reports shared by other users unless you have Create permissions for the folder they are stored in.

To edit a report:

1. Click the report to edit.

2. Click the view that you want to edit.

   The view displays selection handles.

3. Click **Edit** in the Actions list.

   The report displays in the work space.

4. You can do one of the following:
   - Click **Edit view** in the View Tasks/Options list to open the View Editor, which contains the data functions and formatting properties dialogs. You can also double-click the report display to open the View Editor.
   - To change the view type, click **Change view type** in the View Tasks/Options list. Previously selected options for the view are applied to the new view type where possible.

5. When you finish editing the report, click **Save Report** in the Actions list.

You can use the following buttons to move the View Editor when you are editing:

- **Move** button

   Click the **Move** button in the upper left corner of the View Editor to move it to the upper area of the work space so that you can view your changes without closing the View Editor. Click it again to return the View Editor to its original place.

- **Hide** button

   Click the **Hide** button to temporarily minimize the View Editor. Click it again to display the View Editor.
Similar buttons on the side bar allow you to move or hide the list of actions and the Guide text to customize your Active Studio work space.

Adding Report Titles

You can add titles to display at the top of reports.

To add a title to a report:

1. In a report you are editing, click in the **Click to add a report title** text at the top of the report.
   The text changes into a text cursor.
2. Enter the report title.
   The title is saved with the report. You can edit the report title by clicking the title text field and typing. You can format the report title in the Report Properties dialog.

You can also add a display title for each view if your report has multiple views.

Formatting Report Titles

You can format report titles using the Report Properties dialog. You must add a report title before you can format the text.

To format a report title:

1. In a report you are editing, click **Change Report Properties** in the Actions list.
   The Report Properties dialog displays.
2. On the **Title** tab, click a font name from the **Font** list.
3. Click a font style from the **Style** list.
4. Click a font size from the **Size** list.
5. Click the color swatch.
   A color palette displays.
6. Click the new color from the palette.
   The color and the color hex number display. You can also specify the color by typing or pasting a hex number in this field.
7. Choose the effects to apply to the text by clicking the checkboxes for underline, overline, or line through.
8. Choose a case for the text such as capitalize the first letters, all uppercase letters, or all lowercase letters.
9. Click **Apply** or **OK**.

Setting Backgrounds for Reports

You can set a background color an image for reports. The background displays in the title bar, in the space behind view elements, and between views.

To set a background color for a report:

1. In a report you are editing, click **Change Report Properties** in the Actions list.
   The Report Properties dialog displays.
2. On the **Background** tab, click the current color swatch for the report background.
A color palette displays.

3. Select the new color.

The color and the color hex number display for the report background color. You can also specify the color by typing or pasting a hex number in this field.

4. Click OK.

The new background color is applied to the report.

To use an image in the background:

1. In a report you are editing, click Change Report Properties in the Actions list. The Report Properties dialog displays.
2. On the Background tab, select the Image checkbox, and click Browse. The File Upload dialog opens.
3. Click Browse to locate the image.
4. Select an image file and click Open.
5. Click Upload.
6. Click OK to close the File Upload dialog.
7. Click OK to close the Report Properties dialog.

Resizing Views

You can resize a view in a report. You might want to display a larger view, or you might want a smaller view in a report to make room for inserting another view.

To resize a view in a report:

1. In a report you are editing, select the view that you want to resize. The view displays selection handles.
2. Click a handle and drag in the direction that you want to resize the view. The view is resized. You can also move the view without resizing by dragging the frame of the view instead of a selection handle.

Inserting Views

You can insert additional views into a report. After selecting a report template, you might want to arrange views and add more views.

To insert a view into a report:

1. In a report you are editing, click Insert View in the toolbar. The view displays and the selection handles are active.
2. You can do any of the following to arrange your new view:
   - Click a handle and drag in the direction that you want to resize the view.
   - Move the view without resizing by dragging the frame of the view instead of a selection handle.
   - Click Send Backward and Bring Forward in the toolbar to arrange views that overlap.
Deleting Views

You can delete a view from a report. You might want fewer views in a report, and then you can resize the remaining views.

To delete a view from a report:
1. In a report you are editing, click the view that you want to delete.
   The view displays selection handles.
2. Click Delete View in the toolbar.
   The view is deleted.

Changing View Types

You can edit a report and change the view type you selected for a specific view. For example, you might have a three view report and decide to change the first view from a streaming list to an updating ordered list, without creating a new report. Many view types can be changed and still maintain the majority of the properties you already specified.

To change a view type in a report:
1. In a report you are editing, click the view that you want to change.
   The view displays selection handles.
2. Click Change view type in the Actions list.
   The view type icons display.
3. Click the new view type to use.
   The view displays using the data object selected for the old view type.
4. Open the View Editor to make any other formatting selections needed for the new view type.

Switching Data Objects

You can edit a report and change the data object you selected for a specific view. The new data object you select must contain at least the same fields as the originally selected data object. The new data object might contain additional fields. The data objects that do not apply are disabled. To select a completely different data object without starting a new report, create a new view in this report.

To switch a data object in a view:
1. In a report you are editing, click the view that you want to change.
   The view displays selection handles.
2. Click Edit view in the Actions list.
3. Click the Data Objects tab.
   The list of data objects displays. Data objects that are not similar to the original data object are disabled.
4. Make any other formatting selections needed for the new view type.
5. Click OK or Apply.
Setting Active Data Retrieval Interval

When you create active data reports where the amount of changing data is large and changes often, you might want to set a time delay so that more data accumulates before each active data retrieval. This will result in better display performance for the users viewing the report. The ideal setting depends on the data characteristics.

If the report display is not keeping up with the active data and the client machine CPU is completely used, adding a small amount of time provides a chance for more records to collect before being sent so that more records are sent each time. The short delay increases display performance.

Determining the ideal amount of time requires displaying the report and testing which amount of time provides the best results. This setting applies to all the views in the report that display active data.

To set a data retrieval interval:

1. In a report you are editing, click **Change Report Properties** text in the Actions list. The Report Properties dialog displays.
2. Click the **Advanced** tab.
3. Enter a number for the refresh interval in milliseconds, such as 500 to represent half of a second or 2000 for 2 seconds.
4. Click **OK** to save your changes and close the dialog.

Printing Reports

You can print a report you are viewing from the My Reports or Shared Reports tabs.

---

**Note:** All rows may not print in List views. If a List view is broken into two or more pages only the selected page will print. You must select each page and print it separately.

---

To print a report:

1. Click the report to print.
2. Click **View** in the Actions list.
   
   Print Preview and the page orientation options display in the Actions list.
3. Select either portrait or landscape for your page orientation.
4. Click **Print Preview** in the Actions list.
   
   The Print Preview window displays.
5. Click **Print**.
   
   The Print dialog for your printer settings displays.
6. Select printing options such as the printer to send the report to and the number of copies to print.

   If you changed the page orientation in Active Studio, then you must also change the page orientation in your printer settings. Click **Preferences** in the Print dialog, and then click the **Basics** tab to view the page orientation options.
7. Click **Print**.
E-mailing Reports

The printer prints the report.
To close the Print Preview window, click Close.
When you print a columnar report, you can view the print boundaries and the page count.
To print a columnar report:
1. Click the report to print.
2. Click View in the Actions list.
   Print Boundaries and the page orientation options display in the Actions list.
3. Click Print Boundaries to view the page layout and page count.
4. Select either portrait or landscape for your page orientation.
5. Click Print in the Actions list.
   The Print dialog for your printer settings displays.
6. Select printing options such as the printer to send the report to and the number of copies to print.
   If you changed the page orientation in Active Studio, then you must also change the page orientation in your printer settings. Click Preferences in the Print dialog, and then click the Basics tab to view the page orientation options.
7. Click Print.
   The printer prints the report.
8. To turn off the print boundaries, click Print Boundaries again.

Copying Report URLs

You can copy the URL of a saved report so that you can add it to another location, such as a web page in a portal site or a link in an e-mail. The report URL contains the complete report location so that clicking the link displays the report in a browser. The report is displayed in Active Viewer.
To copy a report URL:
1. Select the report in the list in the My Reports page or the Shared Reports page.
2. Click Copy Shortcut in the Actions list.
   The Copy Shortcut dialog displays including the string containing the report URL.
3. Highlight the string, hold down the Control key, and type C to copy the text.
4. Paste the URL string in the new location.

E-mailing Reports

You can e-mail reports or links to reports to yourself or other users.
To e-mail a report:
1. Click the report to e-mail.
2. Click Email in the Actions list, and choose Link a report or Rendered report. A link to a report displays the active report when it is selected. If you select Rendered report for an active report, you can preview the report in the dialog the way that the recipient will view it. Rendered reports are static and do not include
any JavaScript or resizing capabilities. If a web page in an External Content view contains JavaScript, it should not be used.

Rendered reports can only be viewed in Microsoft Outlook. Firefox, Netscape, and other Mozilla clients are not supported for viewing rendered reports.

The Email Report dialog displays.

3. Specify Oracle Business Activity Monitoring user names in the To, Cc, Bcc fields. You cannot send email to users that are not included in the Administrator. See Oracle Business Activity Monitoring Administrator's Guide for information about setting up users.

4. Type a message to the recipient.

5. Click Send.

The email containing the link or rendered report is sent.

**Saving Reports Offline**

You can save reports locally as MHT files. These files are saved on your local machine so that you can view them at another time when you might not have access to Active Studio. The MHT files are viewed in a browser and display the report just as it displays in Active Studio.

To save a report offline:

1. Click the report.

2. Click View in the Actions list.

3. Click Save Offline in the Actions list.

   The Save HTML document dialog displays.

4. Select a folder location to save the file.

5. Type a name for the MHT file and click Save.

To view a report saved offline:

- Locate the MHT file in your local files and double-click it.

The MHT file displays in the Internet Explorer browser. The report display resizes according to the browser window size. Reports saved as MHT files are static and do not show live data.

---

**Note:** When printing a tiled report that has been saved offline, only the visible data will print. Data that is part of multipage views, as in List views, that is not currently displayed, is not printed. The exception to this is the Continuous mode Columnar report.

**Deleting Reports**

You can delete any reports that you own. You cannot delete reports shared by other users unless the report owner gave you Delete permission for the folder containing the report.

To delete a report:

1. Select the report to delete.
2. Click **Delete** in the Actions list.
   A dialog displays to confirm that you want to delete this report.

3. Click **OK**.
   The report is deleted.
This chapter provides detailed information about using each of the views in Active Studio.

This chapter contains the following topics:

- Using List Views
- Using Chart Views
- Using the Columnar View
- Using Key Market Indicator Views
- Using Crosstab Views
- Using Spreadsheet Views
- Using the Action Form View
- Using the External Content View
- Using Utility Views

### Using List Views

This section provides information about the Streaming List, Updating List, Ordered Updating List, Collapsed List, and Action List. It contains the following topics:

- Creating List Views
- List View Formatting Properties
- Sorting Data in List Views
- Adding Summaries to a Collapsed List
- Using the Action List

The following list describes the types of list views available in Active Studio.

- The **Streaming List** displays rows of data that display new rows at the top of the list when active data arrives.

- The **Updating List** displays rows of data that update in place when active data is received. New records are inserted at the top of the list.

- The **Updating Ordered List** displays updated records inserted into a sorted list. The top records are highlighted in up to four colors. You must apply a sort to view the color highlighting.
The Collapsed List displays rows of data that is grouped by a field and lets you display a summary field.

The Action List is modeled on the Updating Ordered List and includes row selection checkboxes or radio buttons so that you can perform an action on selected rows of data.

Creating List Views

This procedure describes the shared steps for creating List views in a report. For individual differences, see the sections.

To create List views:

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click Change view type.
   - If you need a new view to define, insert a new view.
   A group of view type icons displays.

2. Select one of the List views.
   The View Editor opens.

3. Select a data object. The data object is the source of data for the view.

4. Click Next.

5. Select the fields to include in the view.
   In most views you can click select none to clear all of the checkboxes. The link switches to select all so that you can select all fields again.
   If the data object contains 10 or fewer fields, the fields are automatically selected in the Data Fields list. If it has more than 10, you must manually select fields.
   When creating a Collapsed List you must select a field to summarize and choose a summarize function from the list on the right. The list will be grouped by the summarized field. See “Adding Summaries to a Collapsed List” on page 3-3 for more information.

6. Select each field and use the arrow keys to arrange the fields in the order you want to present them (left to right) in the list.

7. Click Next.
   The wizard displays a list of additional options.

8. You can select one of the options to add data modifiers or formatting properties.

9. Click Change View Properties or Formatting Properties to continue formatting the view.

10. Click Finish, Apply, or OK to display the view.

List View Formatting Properties

Although they have differences when displayed, list views have formatting characteristics in common.
In addition to the general properties common to all views (see "Formatting General Properties" on page 4-19) the properties in Table 3–1 are also available.

### Table 3–1 General Properties for List Views

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show When List Empty</td>
<td>When there is no data to display in a list the text entered in the field is shown</td>
</tr>
<tr>
<td>Hide Headings</td>
<td>Hides the column headers in the list</td>
</tr>
<tr>
<td>Click here to edit the window features used when clicking on a link in the List</td>
<td>Properties of the new browser window opened when a link in a list is clicked</td>
</tr>
<tr>
<td>Selected Fields</td>
<td>Determines which columns that are displayed in the list.</td>
</tr>
</tbody>
</table>

### Sorting Data in List Views

Data in the Updating Ordered List, Collapsed List, and Action List views can be sorted by any field. Streaming List and Updating List data cannot be sorted because active data is added to the top of the list.

To sort a List view:

1. Click **Data** in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.
2. Click the **Sort** tab.
3. Click a field in the Report Fields list. You can click more than one field to move multiple fields at the same time.
4. Click the Right arrow to move the field to the Sorted Fields list.
5. Click **Sort Order** next to the field name.
   - The data order and the Sort Order button change to descending.

To define the priority of multiple sorted fields:

1. Click a field in the Sorted Fields list.
2. Click the Up arrow to move the field higher in the list, and click the Down arrow to move the field lower in the list.

### Adding Summaries to a Collapsed List

You can add summaries to a Collapsed List view. You apply a summary function, such as Sum, Average, Min, Max, or Count to a value field. You can also apply the Count function to non-numeric fields.

To add summaries:

1. Click the **Data** button in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.
2. Click the **Fields** tab.
3. Select a value field and select a summary function checkbox.
4. Click **Apply** or **OK** to update the view.
Using the Action List

This section details the procedures for using an Action List view. It contains the following topics:

- Selecting Rows of Data in the Action List
- Editing Data in the Action List
- Adding Action Buttons

Selecting Rows of Data in the Action List
By default the Action List displays a column of checkboxes on the left side so that you can select rows of data. You can display a column of radio buttons making it possible to select only one row of data.

To display a column of radio buttons:
1. Select the Action List view and click Edit view in the View Tasks/Options list. The View Editor opens.
2. Click Properties and select the Actions tab.
4. Click Apply or OK.
   The column of checkboxes is changed to radio buttons.

Editing Data in the Action List
You can edit data in any column in an Action List.

To make columns editable:
1. Select the Action List view and click Edit view in the View Tasks/Options list. The View Editor opens.
2. Click Properties and select the Editable Fields tab.
3. Select the fields to be made editable in the Selected Fields list.
4. Click Apply or OK.
   The columns selected become editable and a Submit button appears in the bottom left corner of the view.

When editing fields you must click the Submit button in order to commit the changes to the data object.

Adding Action Buttons
In order to do something with the selected data in an Action List you need to create Action Buttons. Action Buttons can appear in any report, but a lot of the actions you can define for Action Buttons only apply to the Action List view. See Chapter 8 for more information about creating Action Buttons.

Using Chart Views

This section provides information about the Chart views. It contains the following topics:

- Creating Chart Views
- **Chart View Formatting Properties**
- **Using the Pie Chart**
- **Creating Statistical Process Control Charts**
- **Configuring Time Groups**
- **Creating Charts With Multiple Data Objects**

- The **Bar Chart** shows vertical columns to represent summarized values. Available in 2D and 3D.
- The **Line Chart** shows a graphed line of values or compared values. Available in 2D and 3D.
- The **Area Chart** view shows a graphed line of values with the area filled in for visual comparison. Available in 2D and 3D.
- The **Combo Chart** shows a combination of values as bars, lines, and area charts in the same view. Available in 2D and 3D.
- The **Pie Chart** displays values in segments of a circle. Available in 2D and 3D.
- The **Stacked Bar Chart** provides a bar chart with sets of values as stacked columns instead of side by side. Available in 2D and 3D.
- The Statistical Process Control Charts (**R Chart**, **S Chart**, and **P Chart**) are attribute control charts showing the fraction or percent of nonconforming data out of a given population. Attribute control charts are useful when items are compared with some standard and then are classified as to whether they meet the standard or not.
- The **Funnel Chart** view offers a compelling way to display data that adds up to a 100% total—for example, you can present sales data in a funnel chart for easier sales pipeline analysis.

**Creating Chart Views**

Chart view types include bar, line, area, combo, pie, statistical, funnel, and stacked bar charts. Most charts are available in 2D and 3D styles. Although they have differences when displayed, they have formatting characteristics in common. This procedure describes the shared steps. For individual differences, see.

To create chart views:

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you can click **Change view type**.
   - If you need a new view to define, insert a new view.
   A group of view type icons displays.

2. Select one of the following charts:
   - Bar Chart
   - Line Chart
   - Area Chart
   - Combo Chart
Using Chart Views

- Pie Chart
- Stacked Bar Chart
- R Chart
- S Chart
- P Chart
- Funnel Chart
- 3D Bar Chart
- 3D Line Chart
- 3D Area Chart
- 3D Combo Chart
- 3D Pie Chart
- 3D Stacked Bar Chart

The View Editor displays.

3. Select a data object. The data object is the source of data for the report.

4. Click Next.

5. Select one or more fields to group data by. If the numeric fields needed to group by are in the Chart Values list, select Include Value Fields to display in the Group By list. When you group by week, quarter, or year, week is based on a Sunday through Saturday week, and year is based on a January through December year with Q1 starting January 1.

If you choose to group by a field of type datetime, some additional configuration is required. See “Configuring Time Groups” on page 3-9.

See “Creating Statistical Process Control Charts” on page 3-7 for information about selecting fields for the S Chart, P Chart, and R Chart.

6. Click one or more Chart Values to chart.

7. For each Chart Values field selected, select a summary function in the Summary Functions list.

8. Click Next.

The list of additional options displays.

9. You can select one of the options to add filters, calculations, or additional data objects.

For more information about creating charts with more than one data object see “Creating Charts With Multiple Data Objects” on page 3-10.

10. Click Change View Properties or Formatting Properties to continue formatting the view. Formatting options include General, Axis, Data Labels, Shading, Text & Align, Value Format, Themes, Font, Active Data, Patterns, and Target.

11. Click Finish, Apply, or OK to display the view.

Chart View Formatting Properties

Although they have differences when displayed, chart views have formatting characteristics in common.
In addition to the general properties common to all views (see "Formatting General Properties" on page 4-19) The properties in Table 3–2 are also available.

### Table 3–2 General Properties for Chart Views

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show When Chart Empty</td>
<td>When there is no data to display in a chart the text entered in the field is shown.</td>
</tr>
<tr>
<td>Chart Title</td>
<td>Displays a chart title in addition to the View title. You can enter a custom chart title or choose a field from the list.</td>
</tr>
<tr>
<td>Vertical Axis Label</td>
<td>Displays a label along the vertical axis of the chart (available for all charts except Pie Charts and Funnel Chart). You can enter a custom label or choose a field from the list. Select On Side or At End from the second list to determine the orientation of the label.</td>
</tr>
<tr>
<td>Horizontal Axis Label</td>
<td>Displays a label along the horizontal axis of the chart (available for all charts except Pie Charts and Funnel Chart). You can enter a custom label or choose a field from the list. Select On Bottom or At End from the second list to determine the orientation of the label.</td>
</tr>
<tr>
<td>Display Legend</td>
<td>Displays a legend of the colors and patterns used in the chart (available in all charts except Funnel Chart)</td>
</tr>
<tr>
<td>Include Aggregate Function In Series</td>
<td></td>
</tr>
<tr>
<td>Allow Diagonal Group Labels</td>
<td>When space is limited, allows group labels to be displayed diagonally (available for all charts except Pie Charts and Funnel Chart)</td>
</tr>
<tr>
<td>Show Group Labels</td>
<td>Displays group labels (available for all charts except Pie Charts and Funnel Chart)</td>
</tr>
<tr>
<td>Suppress Empty Groups</td>
<td>When no data is available for a particular group, no pie slice is displayed (available in Pie Charts only)</td>
</tr>
<tr>
<td>Explode All Slices</td>
<td>Displays pie slices in exploded view when the view is opened (available in Pie Charts only)</td>
</tr>
</tbody>
</table>

### Using the Pie Chart

When viewing a Pie Chart, you can double-click a segment of the pie to separate it from the others. Click it again to move it back into place. You can also right-click and select **Explode** to move a segment away from the pie. Then right-click and select **Unite** to return it to its place.

### Creating Statistical Process Control Charts

The Statistical Process Control (SPC) charts demonstrate how consistently your process is performing, and whether you should, or should not, attempt to adjust it. Whether you track revenues, billing errors, or the dimensions of manufactured components, the SPC charts can help you measure, understand and control the variables that affect your business processes.

The S Chart and R Chart are designed to be used primarily with variable data, which are usually measurements such as the length of an object, the time it takes to complete a process, or the number of objects produced in each period. Upper and lower limits are used to determine whether the process is in control.

R Charts are used when you can collect measurements in groups (subgroups) of between two and ten observations. Each subgroup represents a snapshot of the process.
at a given point in time. The charts' x-axes are time based, so that the charts show a
time of the process. For this reason, you must have data that is time-ordered; that is, 
entered in the sequence from which it was generated. For subgroup sizes greater than
ten, use S Charts.

P Charts are used for results of pass/fail tests, such as percent of work orders 
completed within budgeted cost. In this case, a work order is either completed within 
budget or not (pass/fail). P Charts have the advantage of taking into account the 
sample size (the number of work orders completed) and accounting for the high level 
of random fluctuations when the sample size is small (very few work orders 
completed).

The SPC charts are created a bit differently from the other charts described in this 
section. The following sections explains how the data object should be organized and 
how to select fields for the charts.

Creating an SPC Chart Data Object

The data object you design for the SPC charts will have two columns. One column 
indicates which sample group each measurement belongs to, in our example this is a 
group number but it could also be a time stamp. The second column contains the 
measurements. Figure 3–1 is an example of how the SPC data object might look.

Figure 3–1  Data Object For An SPC Chart

<table>
<thead>
<tr>
<th>Row</th>
<th>sample_group</th>
<th>measurement</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>1.9956</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>2.0002</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>1.9996</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>2.0002</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
<td>2.0002</td>
</tr>
<tr>
<td>7</td>
<td>3</td>
<td>1.9996</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>2.0001</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>2.0005</td>
</tr>
</tbody>
</table>

Selecting Fields for SPC Charts

When you are creating the S Chart, R Chart, and P Chart, the field selection is different 
from that of other charts.

There are two selections you must make. Select the field in the Index group that 
contains the data on which sample group the measurements belong to. Also select the 
field in the SPC Chart Measures group that contains the measurements.

In the P Chart, you also create a pass filter in the Etc. field. The pass filter determines 
which measurements are acceptable cases (passes). Enter an expression that will 
determine the pass criteria for the filter. In the example shown in Figure 3–2 the filter 
passes those measurements in the measurement field that are greater than 2.

Figure 3–2  P Chart Pass Filter

| Etc. |<br>Pass filter expression<br>measurement > 2 |
Configuring Time Groups

You can create a chart where the grouping (x axis) is based on a datetime field.

This feature is available in the Bar Chart, Line Chart, Area Chart, Combo Chart, Pie Chart, and Stacked Bar Chart views (2D and 3D).

**Figure 3–3 Time Groups Options**

To configure time groups:

1. In a report that you are creating or editing, select a field of type datetime in the **Group By** list in the Fields tab. The Time Groups options appear on the right side of the tab as shown in Figure 3–3.

2. Select the **Continuous time series** checkbox to display groups for time intervals where no data is available.

   There may be time gaps where the data did not have entries. The **Continuous time series** feature adds groups to the result whose values are zero, so that when the results are shown on the graph, the x axis represents a smooth time series.

   Continuous time series only works if you have chosen a single datetime field to group by. Continuous time series does not work if any additional groupings are selected.

3. Select either **Use time series** or **Use time groups**.
   - **Use time series** displays the data from the first datetime point available to the last in a sequence.
   - **Use time groups** displays data grouped into a set of time intervals. For example, if you select Month from the time unit list, all data from January from all years where data is available will be grouped in one data point on the chart.

4. Select a time unit from the list.

   If you selected **Use time groups**, the groups are described in the following list.
   - **Year** displays groups for all of the years where data is available.
   - **Quarter** displays four groups representing the quarters of a year (January-March, April-June, July-September, and October-December).
   - **Month** displays twelve groups representing the months of the year.
   - **Week** displays 52 groups representing the weeks in a year.
   - **Day of Year** displays groups representing the 365 possible days in a year.
   - **Day of Month** displays 31 groups representing the possible days of a month.
   - **Day of Week** displays seven groups representing the days of the week.
   - **Hour** displays 24 groups representing the hours of a day.
   - **Minute** displays 60 groups representing the minutes in an hour.
Using the Columnar View

- Second displays 60 groups representing the seconds in a minute.

5. Enter a quantity of the time unit to group by. For example, entering a 2 next to the Month time unit will display the groups in two month increments (January and February will be grouped as one data point on the chart).

6. Click Apply or OK.

Creating Charts With Multiple Data Objects

You can use more than one data object in all of the Chart views. This section contains the following topics:

- Adding Data Objects to Chart Views
- Editing Charts Containing Multiple Data Objects
- Removing Data Objects From Charts

Adding Data Objects to Chart Views

To add a second data object to a Chart view do one of the following:

- While creating the view, select Add a Data Object in the More Options, or Finish screen of the wizard.
- Select Manage Data Objects from the View Tasks/Options list. In the Manage Data Objects dialog click Add and select a data object to add to the chart.

Editing Charts Containing Multiple Data Objects

When a chart contains more than one data object the Edit view option does not appear in the View Tasks/Options list.

To edit a Chart view containing multiple data objects:

1. Select Manage Data Objects from the View Tasks/Options list.
   The Manage Data Objects dialog opens.
2. Select a data object and click Edit.
   The View Editor opens.

Removing Data Objects From Charts

To remove a data object from a Chart view:

1. Select Manage Data Objects from the View Tasks/Options list.
   The Manage Data Objects dialog opens.
2. Select a data object and click Remove.
3. Close the dialog.

Using the Columnar View

This section contains the following topics:

- Adding Summaries to a Columnar View
- Columnar View Formatting Properties
The Columnar view is a text report view that includes grouping, summaries, headers, footers, and text formatting. Columnar views can be tiled views in a single page or continuous Columnar reports.

Notes:
- The Columnar view only supports active updates.
- If you create a columnar report with an image in the header, and upgrade to a new version of Oracle Business Activity Monitoring without backing up and restoring the images into the new Oracle Business Activity Monitoring directory, the columnar report displays a red X where the image was inserted. If the image is replaced in the directory, then the columnar report displays the image instead of the red X symbol.

Adding Summaries to a Columnar View

You can apply a summary function to a Columnar view, such as Sum, Average, Min, Max, or Count to a value field. You can also apply the Count function to non-numeric fields.

To add summaries:
1. Open the View Editor. Double-click the view you are editing, or click Edit view in the View Tasks/Options list.
2. Click the Data button in the View Editor.
3. Select the Summary tab.
4. Select a value field in the Report Fields column and select a summary function checkbox in the Summary Functions column.
5. Click Apply or OK to update the view.

Columnar View Formatting Properties

In addition to the general properties common to all views (see "Formatting General Properties" on page 4-19) the properties in Table 3–3 are also available.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Selected Fields</td>
<td>Indicates columns that are displayed in the list</td>
</tr>
<tr>
<td>Report Title</td>
<td>Displays a report title in addition to the View title</td>
</tr>
<tr>
<td>Design Borders</td>
<td>Displays the outlines surrounding the header, footer, and detail areas in the columnar view when creating and formatting. Design borders are not displayed when you view the report.</td>
</tr>
</tbody>
</table>

Using Key Market Indicator Views

This section provides information about the Key Market Indicator (KPI) views. It contains the following topics:
- Creating KPI Views
- KPI View Formatting Properties
The following KPI views are available in Active Studio.

- The **Arrow** and **Market Arrow** are positive or negative number key performance indicators.
- The **Range Gauge** indicates the current value in the context of a range designed for the values.
- The **Dial Gauge** indicates the current value in a numeric marked gauge.

**Creating KPI Views**

KPI view types include arrows and gauges. Although they have differences when displayed, they have formatting characteristics in common. This procedure describes the shared steps.

To create KPI views:

1. In a report that you are creating or editing, select the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click **Change view type**.
   - If you need a new view to define, insert a new view.
   A group of view type icons displays.
2. Select one of the KPI views:
   - Arrow
   - Market Arrow
   - Dial Gauge
   - Range Gauge
   The View Editor opens.
3. Select a data object. The data object is the source of data for the report. Since KPIs display only one value at a time, KPIs require one of the following:
   - a timestamp field and a numeric field in the data object
   - a one row updating data object
   - a filter reducing the output data to a single field
4. Click **Next**.
5. Select a field from each list where you want to display data. You are not required to choose a field for every dropdown list. The field shown in the middle of the arrow or gauge is the indicator field. You must specify a value for this field.

**Note:** The Arrow indicator field requires data that represents the change in information. For example, a number moving from 100 to 80 does not display a down arrow. Instead, a field with -20 should be used for the indicator field to display a down arrow.

6. Click **Next**.
   The list of additional options opens.
7. You can click one of the links to add filters or calculations.

8. Click Change View Properties or Formatting Properties to continue formatting the view. Formatting options include General, Gauge Styles, Shading, Text & Align, Value Format, and Font.

9. Click Finish, Apply, or OK to display the view.

KPI View Formatting Properties

In addition to the general properties common to all views (see "Formatting General Properties" on page 4-19) the properties in Table 3–4 are also available.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background Color</td>
<td>Displays a background color outside the arrow or gauge in the view. Click the current color swatch and select a new color from the palette, or enter the hexadecimal number of the color in the field.</td>
</tr>
<tr>
<td>Display needle movement without transition</td>
<td>Transitions are not used to indicate movement of the Gauge needle. The needle will jump from one position to another. (Gauge views only)</td>
</tr>
<tr>
<td>Gauge Background Color</td>
<td>Displays a background color inside the gauge (Gauge views only). Click the current color swatch and select a new color from the palette, or enter the hexadecimal number of the color in the field.</td>
</tr>
<tr>
<td>Range Gauge Orientation</td>
<td>Indicates whether to display the range colors from green to red, or red to green when reading the gauge left to right. The order you choose should relate to the meaning represented by large numbers in the view. Select whether to display the range colors with green on the left and red on the right or red on the left and green on the right. (Range Gauge only).</td>
</tr>
</tbody>
</table>
Using Crosstab Views

This section explains the use of the Crosstab, Summary Crosstab, and Matrix views. It contains the following topics:

- Creating Crosstab Views
- Configuring Summaries in Crosstab and Summary Crosstab Views
- Crosstab View Formatting Properties
- Using the Crosstab View
- Using the Summary Crosstab View
- Using the Matrix View

The **Crosstab** is a spreadsheet format that combines rows and columns to display a multi-dimensional view of values. A Crosstab is summarized vertically and horizontally for columns and rows.

The **Summary Crosstab** is a spreadsheet format that combines rows and columns to display a multi-dimensional view of values. A Summary Crosstab is summarized horizontally in rows.

The **Matrix** is a spreadsheet format that combines rows and columns to display a multi-dimensional view of values. A Matrix is an exploded view of all the data available.

---

### Table 3–4 (Cont.) General Properties for KPI Views

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value display ranges</td>
<td>Indicates the ranges for Low, Medium, and High on the gauge (Gauge views only).</td>
</tr>
<tr>
<td><strong>Range Gauge value display ranges:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Low:</strong> Enter the minimum value to display in the gauge. This can be a nonzero value. If the value being measured is lower than this minimum, the gauge arrow will be yellow instead of black.</td>
<td></td>
</tr>
<tr>
<td><strong>Transition between Low and Medium:</strong> Enter a value at which the needle leaves the Low range and enters the Medium range of values.</td>
<td></td>
</tr>
<tr>
<td><strong>Transition between Medium and High:</strong> Enter a value at which the needle leaves the Medium range and enters the High range of values.</td>
<td></td>
</tr>
<tr>
<td><strong>High:</strong> Enter the maximum value to display in the gauge. If the value being measured is higher than this maximum, the gauge arrow will be yellow instead of black.</td>
<td></td>
</tr>
<tr>
<td><strong>Dial Gauge value display ranges:</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Minimum Value:</strong> Enter the minimum value to display on the gauge. This can be a nonzero value. If the value being measured is lower than this minimum, the gauge arrow will be yellow instead of black.</td>
<td></td>
</tr>
<tr>
<td><strong>Maximum Value:</strong> Enter the maximum value to display in the gauge. If the value being measured is higher than this maximum, the gauge arrow will be yellow instead of black.</td>
<td></td>
</tr>
<tr>
<td><strong>Increment:</strong> Enter an increment amount to display as lines in the dial. The Maximum Value must be divisible by the number entered here.</td>
<td></td>
</tr>
<tr>
<td><strong>Auto Increment:</strong> Automatically calculates the increments.</td>
<td></td>
</tr>
</tbody>
</table>
Creating Crosstab Views

A Crosstab is a spreadsheet format that combines rows and columns to display a multi-dimensional view of values. A Crosstab is summarized vertically and horizontally for a column or row that is added. Summary functions that you can add to Crosstabs include sum, average, count, minimum (min) or maximum (max). The Crosstab view displays best in reports containing a single view.

To create crosstab views:

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click Change view type.
   - If you need a new view to define, insert a new view.
     A group of view type icons displays.

2. Select a Crosstab view type.
   - Crosstab
   - Summary Crosstab
   - Matrix
     The View Editor displays.

3. Select a data object. The data object is the source of data for the report.

4. Click Next.

5. Select at least one field in the Rows list, Columns list, and Values list. You can move a field from one list to another by dragging it from one list to another list.
   - The Summary Crosstab view has no Columns list since all of the data is summarized in rows.

6. Click Next.
   - The list of additional options displays.

7. You can select one of the links to add filters or calculations.

8. Click Change View Properties or Formatting Properties to continue formatting the view. Formatting options include General, Shading, Text & Align, Font, Value Format, Cond Format, Themes, Active Data, and Driving.

9. Click Finish, Apply, or OK to display the view.

Configuring Summaries in Crosstab and Summary Crosstab Views

You can configure summaries in the Crosstab and Summary Crosstab views. You apply a summary function, such as Sum, Average, Min, Max, or Count to a value field. You can also apply the Count function to non-numeric fields.

To configure summaries:

1. Click the Data button in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.

2. Click the Summary tab.

3. Select a value field in the Values column and click a Summary Function checkbox. Although there are checkboxes, only one summary function can be selected.
Using Crosstab Views

4. Click **Apply** or **OK** to update the view.

**Crosstab View Formatting Properties**

In addition to the general properties common to all views (see “Formatting General Properties” on page 4-19) the properties in Table 3–5 are also available.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show column totals</td>
<td>Displays the totals of the values in the columns</td>
</tr>
<tr>
<td>Show column labels</td>
<td>Displays the labels for each column</td>
</tr>
<tr>
<td>Show column headings</td>
<td>Displays the headings for each column</td>
</tr>
<tr>
<td>Show row headings</td>
<td>Displays the row headings</td>
</tr>
<tr>
<td>Show value headings</td>
<td>Displays the value headings</td>
</tr>
</tbody>
</table>

**Using the Crosstabs View**

This section contains the following topics:

- Filtering the Crosstab View
- Changing the Aggregate Function
- Pivoting
- Rolling Up and Drilling Down

A Crosstab is a spreadsheet format that combines rows and columns to display a multi-dimensional view of values. A Crosstab is summarized vertically and horizontally for columns and rows. You can filter, drill down, roll up, and pivot using the headers in a Crosstab.

**Note:** Printing, saving offline, and emailing are not fully implemented for Crosstab views.

**Filtering the Crosstab View**

You can filter column and row headings in a Crosstab.

To filter values in a column or row heading:

1. In the Crosstab view, click the down arrow next to the heading label.
   
   A list of values for the heading displays with checkboxes next to each value.

2. Deselect the checkboxes of values to hide from the display.

**Changing the Aggregate Function**

You can change the aggregate function applied to the Crosstab.

To change the aggregate function applied to the values:

1. In the Crosstab view, click the current aggregate function in the upper left corner, such as Sales (avg).

   A list of functions for the heading displays.

2. Select the new aggregate function to apply.
The values update and display.

**Pivoting**
You can pivot data by dragging a column heading to become a row heading in the Crosstab view.

To pivot the view of data:
1. Click and drag a heading from a location as a column heading to a row heading.
   A red line displays on the current row headings to indicate where to display it.
2. Release the mouse button to drop the heading in the new location.
   The data displayed in the Crosstab reflects the new combination of row and column headings.

**Rolling Up and Drilling Down**
You can roll up or drill down in headings.

To roll up or drill down for a heading:
1. Click the plus sign (+) to drill down and display the values using the details of the heading.
2. Click the minus sign (-) to roll up values into a whole number for the heading.

**Using the Summary Crosstab View**
This section contains the following topics:
- Filtering the Summary Crosstab View
- Changing the Aggregate Function
- Rolling Up and Drilling Down
- Sorting the Summary Crosstab View

A Summary Crosstab is a spreadsheet format that combines rows and columns to display a multi-dimensional view of values. A Summary Crosstab is summarized horizontally in rows. You can filter, change the aggregate function, drill down, roll up, and sort using the headers in a Summary Crosstab.

**Filtering the Summary Crosstab View**
You can filter column and row headings in a Summary Crosstab.

To filter values in a column heading:
1. In the Summary Crosstab view, click the down arrow next to the heading label.
   A list of values for the heading displays with checkboxes next to each value.
2. Deselect the checkboxes of values to hide from the display.

**Changing the Aggregate Function**
You can change the aggregate function applied to the Summary Crosstab.

To change the aggregate function applied to the values:
1. In the Summary Crosstab view, click the current aggregate function in the upper left corner, such as Sales (sum).
A list of functions for the heading displays.

2. Select the new aggregate function to apply.
   The values update and display.

Rolling Up and Drilling Down
You can roll up or drill down in headings.

To roll up or drill down for a heading:
1. Click the plus sign (+) to drill down and display the values using the details of the heading.
2. Click the minus sign (-) to roll up values into a whole number for the heading.

Sorting the Summary Crosstab View
You can sort the rows in a Summary Crosstab view on the aggregate column.

To sort the Summary Crosstab view:
1. Click the sorting icon next the heading.
2. Select Ascending, Descending, or None.
   The rows are sorted.

Using the Matrix View
A Matrix is a spreadsheet format that combines rows and columns to display a multi-dimensional view of values. A Matrix is an exploded view of all the data available. You cannot sort, filter, drill down, pivot, or change the aggregate function in a Matrix view.

Using Spreadsheet Views
This section contains the following topics:

- Creating Office Web Components and Excel Spreadsheets
- Using the Spreadsheet View
- Using the Excel View

Spreadsheet views display data using Microsoft Excel or Excel Office Web Components spreadsheet formats.

- The Spreadsheet view displays columns containing rows of data in a Microsoft Excel Office Web Component Spreadsheet.
- The Excel view displays columns containing rows of data in a Microsoft Excel Spreadsheet.

Creating Office Web Components and Excel Spreadsheets
You can create Office Web Components and Excel Spreadsheet views and save the content externally from Active Studio.

The Excel view displays columns containing rows of data in a Microsoft Excel Spreadsheet. When you first create a report containing an Excel view, a dialog displays for you to accept a CAB file that contains an ActiveX control. The ActiveX control enables Excel to run inside of Active Studio.
To create Excel views:

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click **Change view type**.
   - If you need a new view to define, insert a new view.

   A group of view type icons displays.

2. Select the Spreadsheet or Excel view type.

   A dialog displays for you to accept a CAB file that contains an ActiveX control. The ActiveX control enables Excel to run inside of Active Studio.

3. Click **OK** to accept the CAB file.

   The View Editor displays.

4. Select a data object. The data object is the source of data for the report.

5. Click **Next**.

6. Select the field checkboxes to include fields.

   Click **select none** to clear all of the checkboxes. The link switches to **select all** so that you can select all fields again.

   If the data object contains 10 or fewer fields, the fields are automatically selected in the Data Fields list. If it has more than 10, you must manually select fields.

7. Click **Next**.

   The list of additional options displays.

8. You can click one of the links to add data modifiers or formatting properties.

9. Click **Change View Properties** or **Formatting Properties** to continue working with the view. Other options include data transfer and applying macros to run before or after each data update. Formatting options include General, Shading, Text & Align, and Font.

10. Click **Finish**, **Apply**, or **OK** to display the view.

When viewing or editing an Excel spreadsheet in Active Studio, you can use the Excel toolbars and menu options. However, you cannot use the **New** and **Save** toolbar buttons from inside Active Studio. You can save the Excel spreadsheet outside of Active Studio.

To save the Excel spreadsheet outside of Active Studio:

1. On the Excel toolbar, click **File>Save As**.

   The Save As dialog displays.

2. Type a file name for the Excel spreadsheet, select a location, and click **Save**.

   Active Studio automatically creates named ranges for each column in the Excel spreadsheet view.

To view the named ranges and their definitions:

   - On the Excel menu bar, select **Insert>Name>Define**.
The Define Name dialog displays. The named range for the entire data set that is specified on the Data Transfer tab in the View Editor is only listed in this dialog when viewing active data.

**Performance Tips**

For best performance in Excel views where data is very large and very active, the following settings are recommended:

- In the Report Properties dialog, on the Advanced tab, increase the active data interval to 3-5 seconds.
- In the Excel menu bar, select **Tools > Options**. On the Calculation tab, select **Manual**. The default setting is Automatic.
- Avoid applying macros to run before and after data.

**Using the Spreadsheet View**

The Spreadsheet displays columns containing rows of data in a Microsoft Excel Office Web Component Spreadsheet.

---

**Notes:**

- Applying sorting to an entire column includes the header. In most cases, you want the header cell to remain as the header cell. When you sort a column, select only the cells that you want sorted.
- Data that is blank displays as (Null) in a Spreadsheet view, although filters on blank strings return the rows containing the blanks as expected. For data objects intended to display in a Spreadsheet view, the data designer might prefer to substitute the blank or null values in the data object with other representative values for clarity. This can be done using Transforms in the Plan that loads the data object.

---

In addition to the general properties common to all views (see "Formatting General Properties" on page 4-19) **Hide Spreadsheet Toolbar While Viewing** hides the toolbar while the Spreadsheet view is in viewing mode.

**Using the Excel View**

The Excel view displays columns containing rows of data in a Microsoft Excel Spreadsheet. When you first create a report containing a Excel view, a dialog displays for you to accept a CAB file that contains an ActiveX control. The ActiveX control enables Excel to run inside of Active Studio.
The Action Form view lets you create an HTML form in a report that can submit information to a data object. The designer of an action form view first decides what the inputs of the form are, and what action is taken. Use an HTML editor to create HTML for the form incorporating all of the necessary inputs. The HTML must be self-contained, but it can use CSS. The HTML must also be valid XML meaning that all tags must be closed and all attributes must have an assignment.

Creating Action Form Templates

Action Form templates contain the HTML needed to create an Action Form view in Active Studio. Before creating the Action Form view, you must first create an HTML form and define an Action Form template in the Architect application.

To create an Action Form template:

1. Create an HTML form.
   
   See the example form on page 3-22. Note that any inputs that you want to map to data objects and parameters must contain an attribute rtseableID that is set to a unique value in the form.

2. Open Architect and select Data Objects from the Architect function list.

3. Select the Action Form Templates data object located in the Data Objects/System/Views folder.

4. Click Contents.

5. Click Edit Contents.

6. Click Add.

7. Enter a Name for the template. This name will appear in the View Editor for the Action Form in Active Studio.

8. You do not need to specify the ID; the system will create it.

9. Enter a brief Description.

Notes:

- Applying sorting to an entire column includes the header. In most cases, you want the header cell to remain as the header cell. When you sort a column, select only the cells that you want sorted.

- Data that is blank displays as (Null) in an Excel view, although filters on blank strings return the rows containing the blanks as expected. For data objects intended to display in an Excel view, the data designer might prefer to substitute the blank or null values in the data object with other representative values for clarity. This can be done using Transforms in the Plan that loads the data object.

Using the Action Form View

This section contains the following topics:

- Creating Action Form Templates
- Creating Action Form Views

The Action Form view lets you create an HTML form in a report that can submit information to a data object.

The designer of an action form view first decides what the inputs of the form are, and what action is taken. Use an HTML editor to create HTML for the form incorporating all of the necessary inputs. The HTML must be self-contained, but it can use CSS. The HTML must also be valid XML meaning that all tags must be closed and all attributes must have an assignment.
10. Enter **html** in the **Type** field. Only the html type is supported.

11. Cut and paste your HTML from your HTML editor into the **FormInput** field.

12. Click **Save**.

**Example HTML Form for Action Form Template**

```html
<html>
<head>
<title>Email Form</title>
<meta http-equiv="Content-Type" content="text/html; charset=iso-8859-1"/>
<link href="styles/CUSTCOOLBLUEv.css" rel="stylesheet" type="text/css"/>
</head>
<body>
<table>
<tr>
<td>To:</td>
<td><div align="left" rtsEnabledID="ToRecipient"></div></td>
</tr>
<tr>
<td>CC:</td>
<td><div align="left" rtsEnabledID="CcRecipient"></div></td>
</tr>
<tr>
<td>BCC:</td>
<td><input type="text" name="text223222" size="49" rtsEnabledID="OtherRecipient"></td>
</tr>
<tr>
<td>Subject</td>
<td><input type="text" name="text22322" size="49" rtsEnabledID="Subject"></td>
</tr>
<tr>
<td>Message</td>
<td><textarea rtsEnabledID="Message" name="textarea" cols="51" rows="6" wrap="virtual"></textarea></td>
</tr>
</table>
</body>
</html>
```

**Creating Action Form Views**

The Action Form view

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click **Change view type**.
   - If you need a new view to define, insert a new view.
A group of view type icons displays.
2. Select the Action Form view type.
   The View Editor opens.

3. Choose a content type to display, and click Next. The content type is an HTML form that was created in Architect. See "Creating Action Form Templates" on page 3-21 for more information.

4. Select Inputs, and click Next. Here you can select fields from a data object or parameters in the current report to populate the form input fields. You can also filter inputs containing lists.

5. Select Associations and click Next. Associations let you automatically populate an input field in your form when a selection is made in another input field. Most often used to populate other fields in the form when selecting an option from a list. (This requires putting data into Util Templates data object in Architect.)

6. Click Finish, Apply, or OK to display the view.

7. Create an Action Button so you can submit the data in the action form to a data object. See Chapter 8 for more information about Action Buttons.

Using the External Content View

The External Content view is for displaying URLs, files, or static images in a report. The External Content view includes only the General tab in Formatting Properties. No other formatting tabs are included.

Notes:

- If users navigate to another page with the External Content view set to refresh, the original URL is displayed again when it refreshes. If the content is static and does not require refreshing, select No for the Refresh this content automatically setting.

- If specifying a file for a report that is shared with other users, the file must be in a shared folder with access granted to the user that the Oracle BAM Data Service runs as. The full path must be specified using the format `\machinename\sharedfolder\filename.jpg`.

- Because the External Content view displays referenced image files, if you delete the image file from the specified location, a red X displays when the report is viewed. The red X indicates that the image cannot be found. Replace the image in the specified location to view it again.

Creating External Content Views

External content views display either a web page external to Active Studio or an image. Images must be in either JPG or GIF format.

To create external content views:

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click Change view type.
If you need a new view to define, insert a new view.

A group of view type icons displays.

2. Click the External Content view type.

The View Editor displays.

3. Select **Web Page** or **Picture From File**.

4. Enter a URL for a web page or browse the location of an image.

5. To refresh the content automatically, click **Yes**, and specify how often to refresh the display. To do this, enter a number and select a measurement of time from the list.

6. Click **Apply** or **OK** to display the view.

### Using Utility Views

The utility views allow you to add functionality to reports and other views. This section contains the following topics:

- Using the Surface Prompts View
- Using the Container View
- Using the Row Group and Column Group Views
- Using the Tab Group View
- Using the Dashboard View

The following utility views are available in Active Studio.

- The **Surface Prompts** view provides space on the report for displaying surface prompts.

- The **Container**, **Row Group**, and **Column Group** views allow you to create views within views.

- The **Tab Group** view is used to arrange reports within reports.

- The **Dashboard** view is used to arrange reports within reports. Dashboard views can consist of a collection of Tab Group reports or a single report of any type.

### Using the Surface Prompts View

In addition to the general properties common to all views (see "Formatting General Properties" on page 4-19), **Go Button Text** enables you to change the text displayed on the Go button.

### Creating Surface Prompt Views

Surface prompts let report users interact with the report content by selecting from a list of items to display. The Surface Prompt view provides a space on the report for displaying the surface prompts.

**Note:** Surface prompt views depend upon prompt filters created in other views for content. If there are no prompt filters defined in other views, nothing will be displayed in the Surface Prompts view.

To create a Surface Prompt view:
1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click Change view type.
   - If you need a new view to define, insert a new view.
   A group of view type icons displays.
2. Select the Surface Prompt view.
3. Click Edit view in the View Tasks/Options list.
4. Select the Surface Prompts tab and select which prompts to display on the report.
   Prompts configured for each of the views will appear in this list. Use the list next to each prompt to show or hide it.
   Formatting options include General, Shading, Text & Align, and Font.
5. Click Apply or OK to display the view.

Using the Container View

Container views allow you to create views within views. You can split a view into two or more frames using a Container view.

In addition to the general properties common to all views (see "Formatting General Properties" on page 4-19) Go Button Text enables you to change the text on the Go button.

Creating Container and Group Views

To create a Container view:

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click Change view type.
   - If you need a new view to define, insert a new view.
   A group of view type icons displays.
2. Select the Container view type.
3. Each new frame displays a selection of view types.

Using the Row Group and Column Group Views

Row Group and Column Group views allow you to create views within a view. You can split a view into two or more frames using a Row Group or Column Group view.

Creating Row Group and Column Group Views

To create Row Group and Column Group views:

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
Using Utility Views

- If you are editing an existing view, you might need to click **Change view type**.
- If you need a new view to define, insert a new view.

A group of view type icons displays.

2. Select a group view type.
   - Row Group
   - Column Group

   Each new frame displays a selection of view types.

3. Select a view for each frame.

Using the Tab Group View

Tab Group views are used to arrange reports within a report. Tab Group views consist of a collection of reports.

Creating Tab Group and Dashboard Views

Tab Group views are dependent upon reports that have already been created and are ready to be placed in a multiple page format.

To create a Tab Group view:

1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click **Change view type**.
   - If you need a new view to define, insert a new view.

A group of view type icons appears.

2. Select the Tab Group view type.

   The View Editor opens.

3. Click **New** to add tabs to the Tab Contents list. The Tab Editor dialog opens.

4. Enter a name for the tab label, and indicate the type of content, Report or URL, that will appear on the tab.

   To display the row count on the tab label select the **Display Row Count from a Data Object on Tab Label** checkbox, and click **Define** to select the data object.

5. Click **OK**.

6. Add more tabs as needed, and click **Finish to display the view**.

Using the Dashboard View

Dashboard views are used to arrange reports within reports. Dashboard views can consist of a collection of Tab Group reports or a single report of any type.

Creating Dashboard Views

Dashboard views are dependent upon reports that have already been created and are ready to be placed in a multiple page format.

To create a Dashboard view:
1. In a report that you are creating or editing, click the frame of the view to display the selection handles.
   - If you are creating a report, select the view in the template.
   - If you are editing an existing view, you might need to click **Change view type**.
   - If you need a new view to define, insert a new view.
     A group of view type icons displays.
2. Select the Dashboard view type.
   The View Editor opens.
3. Select the contents to place in the Dashboard view. You can choose a Tab Group report that you created previously, or you can choose a single report of any type.
4. Click **Finish**.
5. Click **Change View Properties** or **Formatting Properties** to continue working with the view. Other options include toolbar buttons you can add to the Dashboard view. Formatting options include General, Shading, Text & Align, and Font.
6. Click **OK** or **Apply** to display the view.
This chapter provides detailed information about the formatting options and data properties available for each of the views in Active Studio.

This chapter contains the following topics:

- Formatting Views
- Applying Data Modifiers
- Formatting View Properties

**Formatting Views**

Formatting changes the way parts of the view look. A report can contain several views of different types. You apply formatting to each view in a report.

Formatting includes tasks such as adding display titles, formatting text and colors, and adding value formats. Several formatting features apply to specific view types only. Because each of the view types has different characteristics and structures, formatting options change depending on the view type.

**Applying Data Modifiers**

This section explains how to apply filters, top N data, drilling, and calculations to views. It contains the following topics:

- Filtering Data
- Displaying Top N Data
- Using Drilling
- Adding Calculations
- Adding Surface Prompts

**Filtering Data**

You can add data filters to all views.

A simple example filter is Sales is greater than 12000. When this filter is applied to data, only Sales larger than 12000 display in the view. Sales less than this amount are omitted.

You can also create more complex filters that include dependencies on other lines in the filter.
By adding a combination of entries and headers, you can create a hierarchy in the filter.

To filter data:

1. Click the **Data** button in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.

2. Click the **Filter** tab.

   Because no filters have been added, only the first filter header displays.

3. Click **Add new entry**.

   A filter form displays.

4. Choose a field from the **Field** list.

5. Choose an expression from the **Comparison** list. Choices include:
   - **is equal to** returns exact value
   - **is not equal to** returns all values except specified value
   - **is less than** returns values less than specified value.
   - **is less than or equal to** returns values less than or equal to specified value.
   - **is greater than** returns values greater than specified value.
   - **is greater than or equal to** returns values greater than or equal to specified value.
   - **is like** returns values that match a string pattern. Include an underscore (_) as a wildcard for a single character in a string and a percent symbol (%) as a wildcard for one character or more. Wildcard characters can be combined, for example, %mm _00 would return all columns (35mm 200, 35mm 400, 35mm 800). Do not enter any spaces in the expression since spaces are treated as characters in the data match.
   - **is not like** returns values that do not match a string pattern.
   - **is null** returns values where the column is null.
   - **is not null** returns values where the column is not null.
   - **is in list** returns values included in a list. To build a list, click **Edit**. Type a value in the field and click **Add** to add it to the list. Add as many values as needed. Click **Remove** to remove a value. Click **OK** to close the dialog.
   - **is not in list** returns values not included in the list.
   - **is within a time interval** returns the values that occur within the specified time interval. When filtering on a datetime or timestamp field, select **Active Now** to keep the displayed time interval current as time passes. Configure the **Active Now Interval** to specify how often to refresh the display. See "Using Active Now" on page 4-4 for more information.
   - **is within the current time period** returns the values that occur within the specified time unit. When filtering on a datetime or timestamp field, select **Active Now** to keep the displayed time period current as time passes. See "Using Active Now" on page 4-4 for more information.
   - **is within a time period** returns the values that occur within the specified time period. When filtering on a datetime or timestamp field, select **Active Now** to keep the displayed time period current as time passes. See "Using Active Now" on page 4-4 for more information.
6. Choose **Value**, **Field**, or **Formula** from the next list.

If you select **Value**, do one of the following:

- For string fields, click **Options** and select **Browse** to see a list of values. Select a value from the list. Up to 50 values display in the list. The **Value** field can be left blank to create a filter on a blank string.

**Note:** If there are more than 50 values in the field, not all of the values are shown in the **Browse** list. Your Oracle Business Activity Monitoring administrator can configure the number of rows to display in the list. See the *Oracle Business Activity Monitoring Installation Guide* for more information.

- For numeric fields, enter a number in the **Value** field.

- For datetime fields, click the calendar button, and select a date in the calendar and a time on the clock. Then click **OK**. If you selected is within a time interval, is within the current time period, or is within a time period, configure the time period using the lists. Select **Active Now** to keep the displayed time interval current as time passes. See "Using Active Now" on page 4-4 for more information.

- For lists, click **Edit** and then create a list by entering the values and click **Add**. Click **Remove** to remove values from the list. Then click **OK**.

- To set the value to the value of a prompt or parameter, click **Options** and select an existing prompt or parameter. Only prompts and parameters that have the same data type as the selected field in the filter display in the list. You can select a New Parameter/Prompt to create a new prompt or parameter to use in this filter. See Chapter 7 for more information about creating prompts and parameters.

If you select **Field**, select a field in the **Field** list to compare with the first field.

If you select **Formula**, enter an expression in the **Formula** field to compare with the first field.

For example, if you create a list view using the sample Call Center data object and create a filter with the following attributes:

- **Field**: Total
- **Comparison**: is equal to
- **Formula**
- **Formula**: Quantity*2

This filter will yield only those rows where the value in the Total column is equal to twice the value in the Quantity column.

7. Click **Add Entry** to add the entry to the filter expression.

A line is added under the top-level header.

Add combinations of entries and header to create complex filters. Select a different operator for headers to change the entry meanings. For the following options, data is returned when:

- **ALL**: All of the included the entries are true.
- **NONE**: None of the included entries are true.
■ **AT LEAST ONE.** At least one and maybe more of the included entries are true.
■ **NOT ALL.** Some or none of the included entries are true, but not all of the included entries are true.

For numeric data types, nulls are not returned for filters returning values equal to zero or values not equal to zero.

**Using Active Now**
The Active Now feature in data filtering enables you to display in your views a segment of the data that is always within a defined time window. As time passes, the view is updated with the data within the defined time interval in the filter. Older data is removed from the view and newer data is added as time passes.

Active Now is available when you choose one of the following comparison expressions:
■ **is within a time interval**
■ **is within the current time period**
■ **is within a time period**

Active Now behaves differently depending on which comparison expression you choose.

When you choose **is within a time interval**, you can control how often the data is refreshed using the **Active Now Interval** setting.

For example, if you create a filter using **is within a time interval, previous** type, **1, Hours** unit, and **Active Now**, set the **Active Now Interval** to 60 seconds, and the current time is 3:25 p.m., data from 2:25 p.m. - 3:25 p.m. is displayed in the view. When the current time changes to 3:26 p.m., data from 2:26 p.m. - 3:26 p.m. is displayed in the view. Every 60 seconds the oldest minute of data is removed from the view and the newest minute is added.

When you choose **is within the current time period** or **is within a time period**, the data is refreshed when the time period changes.

For example, when you create a filter using **is within the current time period**, the **Hours** unit, and **Active Now**, and the current time is 3:25 p.m., only data from 3:00 p.m. - 3:59 p.m. is displayed in the view until the current time is 4:00 p.m. At 4:00 p.m. all the data from 3:00 p.m. - 3:59 p.m. is removed from the view, and data that accumulates during the 4:00 p.m. - 4:59 p.m. time interval is displayed in the view.

**Displaying Top N Data**
You can choose to display only the top values of the first field series in Bar Chart (2D and 3D), Line Chart (2D and 3D), Area Chart (2D and 3D), Combo Chart (2D and 3D), Stacked Bar Chart (2D and 3D), Ordered Updating List, and Action List views.

In Updating Ordered List and Action List views, you must apply sorting to a field before applying top N. The top N selection applies to the first sorted field.

To display the top N of data:
1. Click the **Data** button in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.
2. Click the **Top N** tab.
3. Select the checkbox next to the **Quantity** field.
Applying Data Modifiers

4. Select a number of values to display between 1 and 100. For example, select 5 to view only the top 5 values.

5. In Ordered Updating List and Action List views, you can select the ranking checkbox and type a name for the field to show the ranking of the top N values.

6. Click Apply or OK to update the view.

Using Drilling

This section contains the following topics:

- Drilling Down
- Drilling Up
- Drilling Through
- Drilling Across
- Adding Drilling Hierarchies to Views
- Enabling Drilling Through to Details
- Configuring Drill-Across Targets
- Drilling Across to a URL

Drilling enables you to select an item in a series and view data at a more detailed level or view the actual data rows. To drill down through multiple levels, the data object must include a dimensional hierarchy that is selected on the Drilling tab in the View Editor.

When designing a view where you want users to be able to drill down into multiple levels, group by the highest level in the hierarchy that you want to use. If you choose an intermediate level, users can only drill down from that level in the hierarchy. They cannot drill upwards above the level you select in the chart.

You can drill in reports that you are viewing, but you cannot drill in reports while you edit them. Active data stops and then restarts when drilling.

**Drilling Down**

Drilling down means to display data one level down the drill path and display it in the same view type in the current report. Drilling down is an option when intermediate levels exist in the drill path and the next level down is not the last level in the drill path. If the next level down is the last level in the drill path, it is only possible to drill through. In some cases, drill through is also not an option since report designers can disable the drill through to detail option.

The drilling areas include bars or labels on horizontal axis in bar charts, and segments or legends in pie charts. Right-click to view the drill options.

To drill down:

- Do one of the following:
  - Move the cursor over the bar or pie slice of the series to drill down in. A magnifying glass icon displays. Click the bar or pie slice to drill down.
  - Right-click the bar or pie slice of the series to drill down in and select Drill Down.
Drilling Up
Drilling up means to display data one level up the drill path.

To drill up:
■ Right-click the bar or pie segment of the series to drill up in and select Drill Up.

Drilling Through
Drilling through means to display data at the lowest level of the drill path and display it in an Updating Ordered List or Action List view. Drilling through displays data at the most detailed list level. Drill through is an option on most chart, KPI and crosstab views unless the report designer deselected the Enable drill through to detail checkbox in the Drilling tab. See "Enabling Drilling Through to Details" on page 4-7 for more information.

You can also configure the drill through target to drill across to another report. See "Configuring Drill-Across Targets" on page 4-7.

To drill through:
■ Right-click the line, bar, or pie slice of the series to drill down in and select Show Details.
■ Left-click the line, bar, or pie slice until you reach the final drill-through target.

Drilling Across
Drilling across means replacing a view with another report (the target), replacing the entire report with another report, or opening a report in a new window.

To drill across:
■ Right-click the view and select the target report name.
■ Select Menu in the view title bar and select the target report name.

Depending on how it is configured, the report replaces the current view, replaces the entire report, or opens in a new window.

See "Configuring Drill-Across Targets" on page 4-7 for more information.

Adding Drilling Hierarchies to Views
You can select drilling hierarchies to enable Drill Through in the following views:
■ Collapsed List
■ Bar Chart (2D and 3D)
■ Line Chart (2D and 3D)
■ Area Chart (2D and 3D)
■ Combo Chart (2D and 3D)
■ Pie Chart (2D and 3D)
■ Stacked Bar Chart (2D and 3D)

You can select a data object that contains dimensions in hierarchies. You create hierarchies in data objects using Architect.

To select a drilling hierarchy:
1. In a report that you are editing, select the Drilling tab.
2. Select the hierarchy to use during drilling.
   If no items display in the list, the data object does not have any drilling hierarchies defined. For information about configuring hierarchies in data objects, see Oracle Business Activity Monitoring Architect User’s Guide.

3. Deselect **Enable drill through to detail** if you want to prevent users from drilling to the underlying data, which are displayed in an Updating Ordered List or Action List view.

4. Click **OK** or **Apply**.

**Enabling Drilling Through to Details**

Whether or not the data object has a dimensional hierarchy defined, you can drill through to view detailed data (shown in an Updating Ordered List or Action List) in any of the following views:

- Collapsed List
- Bar Chart (2D and 3D)
- Line Chart (2D and 3D)
- Area Chart (2D and 3D)
- Combo Chart (2D and 3D)
- Pie Chart (2D and 3D)
- Stacked Bar Chart (2D and 3D)
- Funnel Chart
- Arrow
- Market Arrow
- Range Gauge
- Dial Gauge
- Crosstab
- Summary Crosstab
- Matrix

Not all views that allow drilling through to details allow hierarchical drilling.

To enable drilling through to details:

1. In a report that you are editing, click the **Drilling** tab.
2. Select Enable drill through to detail.
3. Select whether the details should appear in an Updating Ordered List or Action List view.
4. Select the fields to display in the detail view. If none are selected all fields selected to create the view (on the Fields tab) and the drilling hierarchy are displayed.
5. Click **OK** or **Apply**.

**Configuring Drill-Across Targets**

You can configure any view to drill across to another target report. You can replace the current view with the target report, replace the entire report with the target report, or
open the target report in a new window. You can create more than one drill-across target in a view. All views support drilling across.

To configure a drill-across target:

1. In a report that you are editing, select the Drilling tab.


3. Select a Destination Type.
   - Replace the Current View replaces the space occupied by the current view with the target report.
   - Replace the Current Report replaces the entire report with the target report. If you select this option you will see breadcrumbs at the top of the report. To turn off the breadcrumbs, click Change Report Properties, select the Advanced tab, and uncheck the Show Breadcrumbs check box.
   - Launch a New Window opens a new browser in which to display the target report.

4. Optionally select context options.
   - Show With Context includes the target in the right-click menu in any data row or chart element.
   - Show With No Context includes the target in the right-click menu outside of the data rows and chart elements, and it includes the target in the view title bar menu.

5. Click Next.

6. Click Browse to select a target report. If you want to drill across to a URL, see "Drilling Across to a URL" on page 4-8 for more information.

7. Click Next.

8. Optionally, map fields to parameters and prompts in the target report.
   When the target report contains prompts and parameters, you can send values to them by mapping fields in this step. The value will be chosen from the data row or chart element you clicked when choosing the target. For example if you right-click a bar in a Bar Chart view, the field value represented in that bar that are mapped to a prompt or parameter will be sent to the target report.

9. Click OK to close the dialog.

10. To configure this drill-across target to be a drill-through target, click Drill Through in the Drill Across Menu box, and deselect Enable drill through to details in the Drill Level Properties box.

11. Click OK or Apply in the View Editor.

**Drilling Across to a URL**

When launching a target in a new window you can choose any URL, rather than a report, as the target.

To configure a URL drill-across target:

1. In a report that you are editing, select the Drilling tab.

3. Select **Launch a New Window**.

4. Optionally select a context option.
   - **Show With Context** includes the target in the right-click menu when the mouse is in any data row or chart element.
   - **Show With No Context** includes the target in the right-click menu outside of the data rows and chart elements, and it includes the target in the view title bar menu.

5. Click **Next**.

6. Enter a URL in the **Destination URL** field.

7. Enter a **Destination Name** that will appear in the drilling menu.

8. Edit window features as desired.

9. Click **Next**.

10. Map fields to external parameters to build a query string.

11. Click **OK** to dismiss the dialog.

12. Click **OK** or **Apply in the View Editor**.

### Adding Calculations

This section contains the following topics:

- Using Expressions in Calculated Fields
- Using Special Characters in Calculated Fields
- Using HTML in Calculations

You can add calculated fields to views in reports. You can create a calculation based on other fields in the view, for example, fields such as Sales and Costs. The calculator includes aggregate functions, string functions, and date/time functions that you combine with existing data fields to create new calculated fields. Then, you can add these calculated fields to the view or create more calculated fields based on other calculated fields.

If you create an aggregated calculated field for a list view, you are not able to add it as a field in the list.

To add a calculated field:

1. Click the **Data** button in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.

2. Select the **Calculation** tab.

3. Start a calculated field expression by doing one of the following:
   - Select a number, operator, or parenthesis button on the calculator.
   - Select a field from the **Field** list and click **Insert Field**.
   - Select a function from **Expression** list and click **Insert Expr**. See "Using Expressions in Calculated Fields" on page 4-10 for more information.
   - Type directly in the calculated field area.
   - Click **Group By** and select one or more fields to group by. You cannot group on a calculation that does not perform any aggregation.
4. When you have created the calculated field expression, click **Enter**.

   A basic syntax check is performed and displays either a green check mark if the syntax passes or a red exclamation mark if the syntax does not pass.

   If the calculation passes the syntax check, the new field displays in the calculated fields list on the right.

5. To add the field to the view, click the **Fields** tab in the View Editor and click the checkbox next to the new field name.

6. Click **Apply** or **OK** to update the view.

To rename a calculated field:

1. Select the field in the calculated fields list, and click **Rename**.

   The Rename dialog displays.

2. Enter a new name for the calculated field, and click **OK**. The field name must start with a letter or underscore and contain no more than 30 characters (letters, numbers, and underscores). Spaces are not valid.

   If you include a calculated field in a view either as a field or in a filter or other applications, and then you rename it, the calculated field might not perform correctly in the view. Rename a calculated field before adding it to a view or a filter.

To delete a calculated field:

- Select the field and click **Delete**.

   The calculated field is deleted.

**Using Expressions in Calculated Fields**

This section provides the syntax and examples for expressions you can use in a calculated field.

**Avg** returns the average of all values for the given field. **Avg** can accept one field parameter of type **Integer**, **Float**, or **Decimal**.

Syntax:

```
Avg(Number)
```

Example:

```
Avg(Revenue)
```

**Ceiling** returns the largest integer greater than or equal to the value of the specified value. **Ceiling** returns 3 and **Ceiling** returns -2. **Ceiling** can accept one field parameter of type **Integer**, **Float**, or **Decimal** or a numeric value may be entered.

Syntax:

```
Ceiling(Number)
```
Examples:
Ceiling(Total)
Ceiling(3.7)

**Concat** concatenates two strings into one. Concat can accept two field parameters of type String, or string values may be entered.

Syntax:
Concat(String, String)

Example:
Concat(Description, " overstock")

**Count** returns a count of all non-null values. Count can accept one field parameter of any type.

Syntax:
Count( Field )

Example:
Count( SaleComplete )

**CountDistinct** returns a count of distinct values in a field. CountDistinct can accept one field parameter of any type.

Syntax:
CountDistinct( Field )

Example:
CountDistinct( Salesperson )

**DateAdd** adds an offset to the field value. The first parameter for DateAdd must be a field of type DateTime, and the last seven parameters maybe a field of type Integer or an integer value. Zeros may be used where no offset is needed.

Syntax:
DateAdd( DateTime, Years, Months, Days, Hours, Minutes, Seconds, Milliseconds )

Example:
DateAdd( { Last Modified }, 0, 0, 7, 0, 0, 0, 0 )
// adds 7 days to the Last Modified value

DateAdd( { Last Modified }, 0, 0, DaysToFollowup, 0, 0, 0, 0 )
// adds DaysToFollowup number of days to the Last Modified value

**DayName** returns the day name for a date. DayName accepts one field parameter of type DateTime.

Syntax:
DayName( DateTime )
Example:
DayName({Last Modified})

**DayOfMonth** returns the day of the month for a date, in the range 1 to 31. **DayOfMonth** accepts one field parameter of type **DateTime**.

Syntax:
DayOfMonth(DateTime)

Example:
DayOfMonth({Last Modified})

**DayOfWeek** returns the day of the week for a date, in the range 1 to 7. **DayOfWeek** accepts one field parameter of type **DateTime**.

Syntax:
DayOfWeek(DateTime)

Example:
DayOfWeek({Last Modified})

**DayOfYear** returns the day of the year for a date, in the range 1 to 366. **DayOfYear** accepts one field parameter of type **DateTime**.

Syntax:
DayOfYear(DateTime)

Example:
DayOfYear({Last Modified})

**Floor** returns the largest integer less than or equal to the value of the specified field. **Floor** (2.9) returns 2 and **Floor** (-2.3) returns -3. **Floor** can accept one field parameter of type **Integer**, **Float**, or **Decimal** or a numeric value may be entered.

Syntax:
Floor(Number)

Examples:
Floor(Sales)
Floor(46.75)

**Hour** returns the hour value in the range 0-23. **Hour** accepts one field parameter of type **DateTime**.

Syntax:
Hour(DateTime)

Example:
Hour({Last Modified})
**If** creates an If-Then-Else statement. If can accept fields, expressions, and values of any type as parameters.

Syntax:

```
If(x)
    Then(y)
    Else(z)
```

Example:

```
If(Sum(Quantity) > Max(Total))
    Then(1)
    Else(2)
```

**IfNull** returns a specified value, y, if the test value, x, is null. IfNull accepts two parameters that can be fields of any type or values of any type.

Syntax:

```
IfNull(x,y)
```

Example:

```
IfNull(Quantity, 0)
```

**Length** returns the length of the string. Length accepts one parameter that can be a field of type String, a string value in quotes, or an expression containing strings or fields of type String.

Syntax:

```
Length(String)
```

Example:

```
Length(Description)
Length("string")
Length(Concat(Description,"Description"))
```

**Lower** converts the string to lowercase letters. Lower accepts one parameter that can be a field of type String, a string value in quotes, or an expression containing strings or fields of type String.

Syntax:

```
Lower(String)
```

Example:

```
Lower(Description)
Lower("Description")
Lower(Concat(Description,"Description"))
```

**Max** returns the maximum value of the specified field or expression. Max accepts one field parameter of any type, or another valid expression.

Syntax:

```
Max(x)
```
Example:
Max(Quantity)
Max(Concat(Description, ' overstock'))

**Min** returns the minimum value of the specified field or expression. Min accepts one field parameter of any type, or another valid expression.

Syntax:
Min(x)

Example:
Min(Quantity)
Min(Concat(Description, ' overstock'))

**Minute** returns the minute value in the range 0-59. Minute accepts one field parameter of type DateTime.

Syntax:
Minute(DateTime)

Example:
Minute({Last Modified})

**Month** returns the month value for a date in the range 1-12. Month accepts one field parameter of type DateTime.

Syntax:
Month(DateTime)

Example:
Month({Last Modified})

**MonthName** returns the month name for a date. MonthName accepts one field parameter of type DateTime.

Syntax:
MonthName(DateTime)

Example:
MonthName({Last Modified})

**Now** returns the current date and time. Now does not accept any parameters.

Syntax:
Now()

Example:
DateAdd(Now(), 0, 0, 7, 0, 0, 0)
**PercentOfTotal** returns the percent the value represents of the total values for the specified field. PercentOfTotal accepts one field parameter of type *Integer, Float, or Decimal.*

Syntax:

PercentOfTotal(Number)

Example:

PercentOfTotal(Quantity)

**Power** returns one value, x, raised to the power of the second value, y. Power accepts two parameters that can be fields of type *Integer, Float, or Decimal,* or they can be numeric values.

Syntax:

Power(Number,Number)

Example:

Power(Quantity, 2)

**Quarter** returns the quarter value in the range 1-4. Quarter accepts one field parameter of type *DateTime.*

Syntax:

Quarter(DateTime)

Example:

Quarter({Last Modified})

**Repeat** repeats a string for the specified number of times. Repeat accepts two parameter, the first of which may be a string value or a field of type *String,* the second of which may be an integer value or a field of type *Integer.* Either parameter can use an expression that returns a string for the first parameter and an integer for the second value.

Syntax:

Repeat(String,Integer)

Example:

Repeat("string", 5)
Repeat(Description, 2)
Repeat(Description, Quantity)
Repeat(Concat(Description," overstock"),Quantity+2)

**Replace** returns a string, x, with all occurrences of the string, y, replaced by the string z. Replace accepts three field parameters of type *String,* or string values.

Syntax:

Replace(String,String,String)

Example:
Replace(Description, 'ing', 'tion')

**Round** rounds the specified value in the first parameter to the number of decimal places specified in the second parameter, rounding up if the number in the N+1 decimal place is 5 or greater, and rounding down otherwise. Round accepts two parameters that can be fields of type Integer, Float, or Decimal, or numeric values.

Syntax:
Round(Number,N)

Example:
Round(Sales,2)

In this example, if Sales value is 12.345, it will be rounded to 12.35.

**Second** returns the second value in the range 0-59. Second accepts one field parameter of type DateTime.

Syntax:
Second(DateTime)

Example:
Second({Last Modified})

**Substring** returns a substring z characters long from string x, starting at position y. Substring requires three parameters, the first of which must be a string value, or a field of type String, and the second and third of which must be an integer or field of type Integer.

Syntax:
Substring(String,Integer,Integer)

Example:
Substring(Description, 3, 5)

**Sum** returns a summation of all values for the specified field. Sum accepts one field parameter of type Integer, Float, or Decimal.

Syntax:
Sum(Number)

Example:
Sum(Total)

**Switch** creates a Switch statement. Switch can accept fields, expressions, and values of any type as parameters.

Syntax:
Switch(w)
  Case(x):(y)
Default(z)

Example:

**TrimEnd** trims the whitespace characters (space, tab, carriage return, line feed, page feed, form feed, and so on) from the end of the string. `TrimEnd` accepts one field parameter of type `String`. You can also enter an expression that returns a string value.

Syntax:

`TrimEnd(String)`

Example:

`TrimEnd(Description)`
`TrimEnd(Concat(Description, Subcategory))`

**TrimStart** trims the whitespace characters (space, tab, carriage return, line feed, page feed, form feed, and so on) from the beginning of the string. `TrimStart` accepts one field parameter of type `String`. You can also enter an expression that returns a string value.

Syntax:

`TrimStart(String)`

Example:

`TrimStart(Description)`
`TrimStart(Concat(Description, Subcategory))`

**Upper** converts a string to uppercase letters. `Upper` accepts one parameter of type `String`. You can also enter an expression that returns a string value.

Syntax:

`Upper(String)`

Example:

`Upper({License Plate Number})`

**Week** returns the week for a `DateTime` value, in the range 0 to 53, since there might be the beginning of a week 53, where Sunday is the first day of the week. Week 1 is the first week with a Sunday in this year.

For example, in the year 2006, January 1st is a Sunday, so there is no week 0. The year starts with week 1 and continues to week 53. Week 53 of 2006 includes only one day, which is December 31st (also a Sunday). The Monday through Saturday following this (January 1-6 of 2007) are in week 0 of 2007.

Syntax:

`Week(DateTime)`

Example:
Week({Last Modified})

**Year** returns the year value in the range 1000-9999. **Year** accepts one parameter of type **DateTime**.

**Syntax:**

`Year(DateTime)`

**Example:**

`Year({Last Modified})`

---

**Using Special Characters in Calculated Fields**

The reserved or special characters in the calculator are `+ / * - ( ) " { } % ,`.

Field names containing any special characters must be surrounded with curly braces `{}`. If field names contain only numbers, letters and underscores and begin with a letter or underscore they do not need curly braces. For example, if the field name is `Sales+Costs`, the correct way to enter this in a calculation is `{Sales+Costs}`.

Double quotes must be escaped if used inside double quotes. For example, `Length(""Hello World, " " I said")`.

---

**Using HTML in Calculations**

You can add HTML tags to calculated fields in order to add special formatting to the field.

The following example guides you through the steps for using HTML in calculated fields.

1. Create a new report using the Streaming List view.
2. When the View Editor opens, select the **Call Center** data object in the Samples folder and click **Next**.
3. Select all of the fields and click **Next**.
4. Click **Create a calculated field**.
5. Enter the following in the expression box:
   
   ```
   If(Total > 50)
   Then(Concat(Concat("<div style='color:red'>","Total","</div>"))
   Else(Concat(Concat("<div style='color:green'>","Total","</div>"))
   ```
6. Click **Enter**. The field name appears in the calculated fields list.
7. Click **Apply**.
8. Select the **Fields** tab.
9. Select the calculated field and click **Apply**.
10. Select the **Properties** icon and select the **Value Format** tab.
11. Select the calculated field from the **Apply To** list.
12. Select **HTML** from the **Category** list.
13. Click **OK**. The calculated field shows the Total values in green or red.
Adding Surface Prompts

You can add surface prompts to List, Chart, KPI, Crosstab, Spreadsheet, Excel, and Surface Prompts views.

1. Create a Prompt in the report. See “Creating Prompts” on page 7-2 for more information.
2. Click the Data button in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.
3. Select the Surface Prompts tab.
   The prompts available in the report are listed in the View Prompts box.
4. Use the Display in list to determine where a prompt should be displayed.
5. Use the Go Button Location list to determine where the Go button should be displayed.
6. Enter new text for the Go button if desired in the Go Button Text box.
7. Click OK or Apply.

Formatting View Properties

This section describes how to change the default formatting in views. It contains the following topics:

- Formatting General Properties
- Formatting Axis Properties
- Formatting Borders and Shading
- Formatting Text Alignment
- Displaying Data Labels
- Formatting Fonts
- Formatting Themes
- Formatting Values
- Formatting the Display of Active Data

When you create or edit a view, select the Properties button to display the formatting options.

Formatting General Properties

To specify general properties:

1. Click the Properties button in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.
2. Select the General tab.
   The following general properties are available in all views:

   - View Title displays a title and title bar for this view in the report. Every view in a report can have its own title. The view title bar is also used to display surface prompts, menus, and the additional information button.
Display additional info button creates an icon in the view title with additional information that you enter in the field.

Allow view to be detached from report creates an icon in the view title that when clicked opens the view in a new browser window. You can edit the browser window settings by clicking the link.

Depending on the view you select there might be more options. See the related sections in this chapter for information about general options for each view.

3. Click Apply or OK.

Formatting Axis Properties

For chart views (except Pie Chart), you can format the axes or accept the automatic axis formatting. Auto formatting adjusts the axes for active data. Other view types do not contain axes.

To specify axis properties:

1. Click the Properties button in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.

2. Select the Axis tab.

3. To use the automatic axis formatting, select the Auto Axis checkbox. If you turn off Auto Axis, you must specify numbers for the following settings:
   ■ Data Axis Min
   ■ Data Axis Max
   ■ Major Increment Marks
   ■ Minor Increment Marks

4. If your view type is a Combo Chart, you can choose to display a secondary axis by selecting the Display Secondary Axis checkbox and specifying the secondary axis settings.

5. Click Apply or OK.

Formatting Borders and Shading

You can format the background color and borders of the view, the view title bar, column headers and any column in a list view, the report prompt input dialog, the report prompt selected option, and the Go button.

To format shading:

1. Click the Properties button in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.

2. Select the Shading tab.

3. Select a target from the Apply To list.

4. Click the color swatch next to the Color field to change the background color.

5. Click the new color from the palette.
The color and the color hex number display. You can also specify the color by typing or pasting a hex number in the **Color** field.

6. Click **Apply** or **OK**.

To format borders:
1. Click the **Properties** button in the View Editor.
2. Select the **Shading** tab.
3. Select a target from the **Apply To** list.
4. Next to a border type, select a line style from the list, such as solid or double.
5. Click the color swatch next the list you selected.
   A color palette displays.
6. Click the new color from the palette.
   The color displays in the swatch.
7. Enter a number next to the color swatch to indicate the line thickness.
8. In the **Margin** group (View target only) you can adjust the amount of white space between the view borders and the data displayed in the view.
9. Click **Apply** or **OK**.

### Formatting Text Alignment

The Text & Align tab in the View Editor lets you adjust the alignment of labels in the view including the view title, column headers, and column text. You can configure text wrapping properties and edit column headers.

To format text alignment:
1. Click the **Properties** button in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.
2. Select the **Text & Align** tab.
3. Select a target from the **Apply To** list.
4. Edit the column heading name by entering a new name in the **Column Heading** text field. This name displays in the view but does not change the column name in the data object.
5. Select a radio button for horizontal text alignment, and where applicable, for vertical text alignment.
6. Select one of the following properties:
   - **None** applies no formatting. Text longer than the column is wide is truncated.
   - **Wrap text** causes data to start on a new line if the column is not wide enough to display all information.
   - **Wrap text (break words)** breaks long words to wrap them. No hyphen is used.
   - **Ellipses** truncates data after a set width and displays ellipses as an indicator in list view types only.
   - **Width** is the set width for the column measured in pixels, inches, or percentage.
- **Height** is the set height for the row measured in pixels.

7. Click **Apply** or **OK**.

### Displaying Data Labels

In chart view types, you can choose to display data labels that show values, percentages, or data series names.

To display data labels:

1. Click the **Properties** button in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.
2. Select the **Data Labels** tab.
3. Select the checkboxes to display data labels.
   - You can select any combination of label types to display.
4. Click **Apply** or **OK**.

### Formatting Fonts

The Fonts tab in the View Editor lets you select and format the fonts used in the view.

To format fonts:

1. Click the **Properties** button in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.
2. Select the **Font** tab.
3. Select a target from the **Apply To** list.
4. Select a font name from the **Font** list.
5. Select a font style from the **Style** list.
6. Select a font size from the **Size** list.
7. Click the color swatch to change the font color.
   - A color palette displays.
8. Select a new color from the palette.
   - The color swatch changes color and the color hex number displays in the **Color** field. You can also specify the color by typing or pasting a hex number in this field.
9. Choose effects to apply to the text by selecting the checkboxes and radio buttons.
10. Click **Apply** or **OK**.

### Formatting Themes

You can select themes for chart views and the Crosstab view.

To choose a theme:

1. Click the **Properties** button in the View Editor. To open the View Editor, double-click the view you are editing, or click **Edit view** in the View Tasks/Options list.
2. Select the **Themes** tab.
3. Select a radio button to choose a color scheme.
   
   If your chart only includes two colors, the colors are applied in the order listed in the color scheme. If your chart requires more than seven colors, the colors are repeated with patterns applied to represent more values.

4. Click Apply or OK.

Adding and Changing Themes

You can change the theme colors and add more themes using the Architect web application.

To add a theme:

1. Open the Architect web application and select Data Objects from the list.
2. Select the Chart Themes or Matrix Themes data object located in the Data Objects/System/Views folder.
3. Click Contents.
4. Click Edit Contents.
5. Click Add.
6. Enter a Name and unique Number.
7. Enter a hexadecimal number corresponding to each color choice in each of the color fields. Chart Themes can have up to 16 colors. Matrix Themes let you specify a Border Color, Heading Border Color, and Cell Border Color. In addition you can add up to 10 colors and 10 font colors.
8. Click Save.

Formatting Values

Use value formatting to apply currency or decimal formatting to a field containing numeric values, or to apply date formatting to datetime fields. You can specify value formatting when you create or edit a report from the View Editor.

To specify value format:

1. Click the Properties button in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.
2. Select the Value Format tab.
3. Select a field from the Apply To list.
4. Select the category describing the value format, and do one of the following:
   - If you select General, no other formatting selections must be made.
   - If you select Number, specify a negative number format, the number of decimal places to include, and click the Digits Grouping Symbol checkbox to apply the comma as a thousands separator. Select the Round to the nearest checkbox to display numbers in shorter form such a 20K for 20,000.
   - If you select Percent, specify the number of decimal places to include.
   - If you select Currency, specify a negative number format, the number of decimal places to include, and a currency symbol. Select the Round to the nearest checkbox to display numbers in shorter form such a 20K for 20,000.
Formatting View Properties

- If you select Timestamp, specify a timestamp format. You can select Adjust time zone from GMT to checkbox to make time zone adjustments.
- If you select Time or Date, choose a type of time or date format in the Type list. You can select Adjust time zone from GMT to checkbox to make time zone adjustments.
- If you select TimeUnit, choose the unit of time to represent from the Type list.
- If you select HTML, no other formatting selections must be made.

5. Select the Zero checkbox and enter a value to substitute for zero values. This option is only enabled for Number, Currency, and Percent formats.
6. Select the NULL checkbox and enter a value to substitute for null values.
7. Click Apply or OK.

Formatting the Display of Active Data

You can format the look of the active data as it is added to the view. You can specify a color and a time interval to indicate how recently the information arrived.

To format the display of active data:
1. Click the Properties button in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.
2. Select the Active Data tab.
3. Click the New Transaction Color color swatch.
   A color palette displays.
4. Select the new color.
   The color and the color hex number display for the new transaction color. You can also specify the color by typing or pasting a hex number in this field.
5. Enter a number in the New Transaction Highlight Interval field to indicate the length of time to highlight new data.
6. Click Apply or OK.

For the Updating Ordered List view you can select Show Rank Colors.

In the Action List view you can select Show Rank Colors and Does not support active data.

For Chart views you can select Disable chart movement on transition to improve performance, and you can uncheck Show New Transaction Color to disable the color change that highlights active data.

For Columnar Reports only, you can also click the Use the fade transition effect for Active Data checkbox. If you have large amounts of active data, this setting is not recommended. The New Transaction Highlight Area property lets you select Entire Row or Cell Only to indicate where active data is.
This chapter describes how to edit a columnar report. Additional information about Columnar Reports is available in "Creating Columnar Reports" on page 2-4.

This chapter includes the following topics:

- About Columnar Reports
- Using Formatting Toolbars
- Inserting Images
- Inserting Text

About Columnar Reports

Columnar reports have different characteristics than tiled reports. A tiled report contains one or more views of data on a single page. A columnar report creates a multiple-paged, continuous formatted report. When you select the Columnar Report template, the Columnar view is also automatically selected. You can also select a tiled report template and the Columnar view although multiple pages are not provided for printing.

The data and properties formatting options in the Columnar Report are identical to those in the Columnar view available in tiled reports. See "Using the Columnar View" on page 3-10 for information about using the View Editor with the Columnar view.

Using Formatting Toolbars

When you edit a Columnar Report, additional toolbars are provided for formatting text and alignment. You can also insert text and images.

![Figure 5–1  Font Formatting Toolbar](image)

To use the font formatting toolbar:

1. Click a column or header containing text.
2. Do any of the following:
   - Select a font and size from the lists.
   - Click the Font Color button to select a font color from the palette.
- Click **Bold**, **Italic**, or **Underline** to apply styles to the font.

**Figure 5–2  Text Alignment Toolbar**

![Text Alignment Toolbar]

To use the text alignment toolbar:

1. Click a column or header containing text.
2. Click a button to apply left, center, right text alignment, or apply the best fit to the column.

**Figure 5–3  Item Alignment Toolbar**

![Item Alignment Toolbar]

To use the item alignment toolbar:

1. Click a column or header containing more than one item, for example, two text fields.
2. Click a button to apply left, center, or right horizontal alignment to the items.
3. Click a button to apply top, middle, or bottom vertical alignment to the items.

**Inserting Images**

You can insert images into Columnar reports. The image file types, JPG and GIF, are supported. For best performance, insert images with smaller file sizes.

To insert an image into a columnar report:

1. Click a text area in the report, such as the report header or a group header.
2. Click the **Insert Picture** button in the toolbar.

**Figure 5–4  Insert Picture Button**

![Insert Picture Button]

The File Upload dialog opens.

3. Click **Browse**, select an image file, and click **Open**.
   The path to the file is inserted.

4. Click **Upload**.
5. After the file is uploaded, click **OK**.
   The image displays in the report. The image will be copied to the server machine.

To delete images:

1. Click the image in the report.
2. Click the **Delete Object** button in the toolbar.
You can insert text into Columnar reports.

To insert text into a columnar report:

1. Click a text area in the report, such as the report header or a group header.
2. Click the Insert Text button in the toolbar.

To delete inserted text:

1. Click the text box in the report.
2. Click the Delete Object button in the toolbar.

The text is deleted.
This chapter describes how to use Alerts.
This chapter contains the following topics:

- Introducing Alerts
- Building Alert Rules
- Using Alert Rule Options
- Creating Alert Rules From Templates
- Creating Alert Rules With Messages
- Creating Complex Alerts
- Modifying Rules for Alerts
- Viewing Alert History
- Clearing Alert History
- Activating Alerts
- Launching Alerts by URL
- Deleting Alerts
- Parameterized Alerts

**Introducing Alerts**

Alerts are launched by a set of specified events and conditions, known as a Rule. Alerts can be launched by data changing in a report or can be used to send a report to users daily, hourly, or at set intervals. Events in an alert rule can be an amount of time, a specific time, or a change in a specific report. Conditions restrict the alert rule to an event occurring between two specific times or dates. As a result of events and conditions, reports can be sent to users through email.

Alerts can be created in the Architect also. See Oracle Business Activity Monitoring Architect User’s Guide for more information.

**Building Alert Rules**

To build an alert rule:

1. Select the Alerts tab in Active Studio.
2. Click Create A New Alert.
The Rule Creation and Edit dialog displays.

3. Click **Create A Rule**.

4. Enter a name for the alert rule.

5. Select an event that will launch the alert. See "Events" on page 6-2 for descriptions of each event.

6. Click **Next**.

7. Select one or more conditions, if needed. See "Conditions" on page 6-3 for descriptions of each condition.

8. Select one or more actions. See "Actions" on page 6-3 for descriptions of each action.

9. In the rule expression, click each underlined item and specify a value to complete the alert rule. For example, click **select report**, and choose a report in the dialog that displays. Other values you define include user names receiving reports, dates and times, time intervals, and filter expressions for a specific field. To continue adding conditions or actions, click the last line in the expression and then select another condition or action.

   You can click the **Back** and **Next** buttons to navigate between the Events page and the page containing actions and conditions, and make changes to those parts of the alert rule expression already constructed.

10. You can click the **Frequency Constraint** button to set a limit to how often an alert can launch. The default frequency constraint for alerts is five seconds. Type a number and select a time measurement such as seconds, minutes, or hours, and click **OK**. To turn off the frequency constraint, uncheck the **Constraint Enabled** checkbox. For more information about frequency constraint see "Frequency Constraint" on page 6-4.

11. Click **Delete this expression** to remove lines from the alert rule.

12. Click **OK**.

   The alert rule is added to list and is active.

### Using Alert Rule Options

The following are the options for creating alert rules.

#### Events

Events launch the rule and trigger the action. Each rule contains only one event.

- **In a specific amount of time.** Select a time interval in seconds, minutes, or hours.
- **At a specific time today.** Select a time.
- **On a certain day at a specific time.** Select a specific date and a time.
- **Every interval between two times.** Select a time interval and two times.
- **Every date interval starting on certain date at a specific time.** Select a date interval such as day, week, month, or year, and a specific date and time.
- **When a report changes.** Select a report to monitor.
- **When a data field changes in data object.** Select a data object and a data field to monitor.
Using Alert Rule Options

- **When a data field in a report meets specified conditions.** Select a report, the data object, and create a filter on the field to monitor.

- **When a data field in a data object meets specified conditions.** Select a data object and create a filter on the field to monitor.

- **When this rule is launched.** No options to select. When this rule is launched is the event to create dependencies between rules.

**Conditions**
Conditions are optional. You can select any number of conditions.

- **If it is between two times.** Select two times.

- **If it is between two days.** Select two dates.

- **If it is a particular day of the week.** Select a day of the week.

**Actions**
Actions are the results of a launched alert. You can select any number of actions.

- **Send a report via email.** Select a report, select to send the report as a report link or as a rendered report, and select a recipient.

- **Send a report via Active Messenger.** This option is not supported.

- **Send a report via the recipient's alert delivery settings.** Select a report and select a recipient. Recipients can configure their own alert delivery settings and delivery order through the personalize link.

- **Send a message via email** Create a message to send and select a recipient.

- **Send a message via Active Messenger.** This option is not supported.

- **Send a message via the recipient's alert delivery settings.** Create a message to send and select a recipient.

- **Send a report via Active Messenger and escalate to another user after a specific amount of time.** This option is not supported.

- **Send a report via email and escalate to another user after a specific amount of time.** Create a message and send to a recipient. Select a secondary recipient to receive the message if the first recipient does not respond within the specified time period.

- **Send a parameterized message.** You can use this option to send reports to other users under the conditions specified. This action is available for the events When a data field changes in data object and When a data field in a data object meets specified conditions. See "Parameterized Alerts" on page 6-7 for more information.

- **Launch a rule.** Select a dependent rule that includes the when this rule is launched event. For an example of constructing a dependent rule see "Creating Complex Alerts" on page 6-5.

- **Run a Plan.** Select a plan to run.

- **Launch rule if an action fails.** Select a dependent rule to launch if any of the actions included in the rule fail. For an example of constructing a dependent rule see "Creating Complex Alerts" on page 6-5.
**Creating Alert Rules From Templates**

Alert rule templates are a convenient preselected group of events and conditions based on some common use cases.

To create an alert rule from a template:

1. Click **Create A New Alert**.
   The Create Alert Rule dialog displays.
2. Click **Create A Rule From A Template**.
3. Enter a name for the alert rule.
4. Select a template from the list.
5. In the **Rule Expression** box, click each underlined item and specify a value to complete the alert rule. For example, click **select report**, and choose a report in the dialog that displays. Other values you define include user names receiving reports, dates and times, time intervals, and filter expressions for a specific field.
6. You can click **Frequency Constraint** to specify how often an alert can launch. The default frequency constraint for alerts is five seconds. Enter a number and select a time measurement such as seconds, minutes, or hours, and click **OK**.
7. You can click **Modify this rule** to modify the rule without using the template. This provides more options for creating rules.
8. Click **OK**.

   The alert rule is added to list and is active.

---

**Note:** Active Studio URLs used in alerts and report links contain a virtual directory using the product build number for caching and performance purposes. This directory must be included in links, and it is not recommended to edit these links. Links created with a previous version of Oracle Business Activity Monitoring will not work after a product upgrade. The alert will require editing or the report shortcut will need to be copied again.

---

**Creating Alert Rules With Messages**

You can create alert rules that send messages. The messages can contain information such as report names, links to reports, and user names. Messages can also include variables that are set when the alert is launched, such as the time that an event occurred and the data that launched the event. To use data variables, the event must be based on data.
To create an alert rule that includes a message:

1. Start building an alert rule.
2. Select one of the following actions:
   - Send a message via email
   - Send a message via the recipient’s alert delivery settings
3. Click create message in the rule expression.
   The Alert Message dialog displays.
4. Enter a subject in the Subject line.
5. Enter the message in the Message Text box.
6. Include special fields into the message.
   Special fields are listed in the box in the lower left corner of the Alert Message dialog. The special fields listed change when reports are selected on the right side of the dialog.
   To insert a special field into the message:
   a. Select a special field from the list.
   b. Click Insert into subject or Insert into text.
   You can insert multiple values of the same type, for example, multiple links to different reports.
   - Send Report Name inserts name of selected report.
   - Send Report Owner inserts owner name of selected report.
   - Send Report Link inserts link to selected report.
   - Changed Report Name inserts name of the changed report.
   - Changed Report Owner inserts Owner Name Of Changed Report.
   - Target User inserts user name of message recipient.
   - Date/Time Sent inserts date and time of message sent.
7. Click OK.

Creating Complex Alerts

You can create nested rules with many actions and chained rules that launch other rules.

You can chain rules by creating two types of rules:
- A dependent rule that must be launched by another rule.
- A rule with an action to launch a dependent rule.

To create dependent rules:

1. Create a rule that includes the event When this rule is launched. There is no value to specify for this event. This is the dependent rule that is launched by another rule.
2. Create a rule that includes the action Launch a rule or Launch rule if an action fails. The Launch rule if action fails applies to any of the actions contained in the rule. This is a rule with an action to launch a dependent rule.
3. Click select rule in the action.
   The Select Dependent Rule dialog displays.
4. Select a dependent rule. Only rules that include the When this rule is launched event display in the list.
5. Click OK.
   To handle a failing action, add the action Launch rule if action fails. For example, if a rule is supposed to send a message, and for some reason the message does not send, you could launch another rule to notify you.

**Modifying Rules for Alerts**

You modify alert rules from the Alerts tab.

To modify an alert rule:

1. Click the alert rule to edit.
2. Click Edit alert in the Actions list.
   The Rule Creation and Edit dialog displays.
3. Make changes to the alert and click OK.
   When you modify alert rules created from a template, you can add new lines and select conditions and actions the same as when you build alert rules without templates.

**Viewing Alert History**

You can view recent history of alert activity on the Alerts tab. The Alerts History list displays the 25 most recent alerts launched.

In the Alerts History list, you can view recently launched alerts, the user who created the alerts, and the time and date that the alerts launched. Alerts that included report links in them provide links to the report from the report history list.

**Clearing Alert History**

When many alerts are actively launching and the alert history list becomes long, you might want to clear your alert history list.

To clear the alert history:

1. On the Alerts tab, click Clear alert history.
   A message displays to confirm that you want to clear alert history.
2. Click OK.
   The alert history list is deleted. New alerts launched after clearing will appear in the alert history list.

**Activating Alerts**

When you create an alert rule, it is automatically active. If you want an alert to be temporarily inactive but you do not want to delete it, you can turn it off by deselecting the Activate checkbox.
To change the activity status of an alert rule:

1. Select the Alerts tab.
2. Select the Activate checkbox for the alert rule.
   
   A checked box means the alert rule is active.
   An unchecked box means the alert rule is inactive.
   
   Checking the Activate checkbox does not cause an alert to launch, it only enables the rule so that if the specified event occurs, the alert will launch.
   
   An exclamation mark on the alert icon indicates it has launched and will not be valid again or because items that it references are missing and it cannot launch.

## Launching Alerts by URL

You can use the alerts web service to manually launch alerts. For more information, refer to:

http://<host>:<http_port>/oraclebam/services/manualrulefire.asmx?op=FireRuleByName

You define the rule name using the format:

DOMAIN\username.alertname

## Deleting Alerts

To delete an alert:

1. On the Alerts tab, select the alert to delete.
2. Click Delete alert in the Actions list.
   
   A dialog displays to confirm that you want to delete the alert.

3. Click OK.
   
   The alert is deleted.

## Parameterized Alerts

When creating a parameterized alert, you must populate the set parameters section. In this section, populate the User, Delivery, and Report fields with either predefined values or dynamically from a Data Object field.

- **User field**

  If you populate this field with predefined values, the value that appears must follow a format such as MY-DOMAIN\myhost-pc. If you populate this field from a Data Object field, the value also follows a format such as MY-DOMAIN\myhost-pc.

- **Delivery field**

  If you populate this field with predefined values, the value that appears in this field is Email (or something similar). If you populate this field from a Data Object field, the value must be smtp.

- **Report field**
If you populate this field with predefined values, the value that appears in this field is Emp_Report (or something similar) If you populate this field from a Data Object field, the value must be the report ID of that report, and not the name. To get the report ID, click the report (for example, Emp_Report) and click the Copy Shortcut link. A window displays with a link such as:


In this link the ReportDef value, 1, is the report ID of the report Emp_Report. Every report in Oracle Business Activity Monitoring has a unique report ID.
This chapter contains information about using prompts and parameters.

This chapter contains the following topics:

- About Prompts and Parameters
- Creating Parameters
- Creating Custom Parameters
- Creating Prompts
- Working with Prompts and Parameters
- Using Parameters in Report URLs
- Driving Prompts and Parameters from Other Views

### About Prompts and Parameters

Parameters are similar to variables that represent substituted values. Prompts are dialogs displayed before the report opens so that the user can specify a parameter value. You can create prompts that display when a user views a report. The user must specify a value in the prompt dialog which is used to limit or customize the view of data in the report. You can also create parameters that contain values. Parameters are not displayed to the user when the report is run.

You must apply prompts and parameters in a report by using them in filters. You can create prompts and parameters from the Report Properties dialog or when you are creating a filter. The Prompts and Parameters page in the Report Properties dialog provides a central way to manage, edit, and delete both prompts and parameters for the entire report.

You cannot create alerts on reports that contain prompts or parameters. You cannot maintain alerts on reports if you add prompts or parameters to the report. The alerts become invalid and cannot be launched.

### Creating Parameters

You can create parameters in the Change Report Properties dialog or in a filter when you specify a value. Creating parameters in the Change Report Properties dialog does not make them active in the report until they are used in a filter. Parameters do not prompt the user to specify a value. The report designer specifies the value for a parameter.

To create a new parameter:
Creating Custom Parameters

Custom parameters are special parameters for Action Buttons that are available to every report in your Oracle Business Activity Monitoring installation. To create custom parameters you must edit the Custom Parameters data object in the Architect web application.

To create a Custom Parameter:

1. Open the Architect web application and select Data Objects from the list.
2. Select the Custom Parameters data object located in the Data Objects/System/Custom Parameters folder.
3. Click Contents.
4. Click Edit Contents.
5. Click Add.
6. Enter a name for the Custom Parameter. This name will appear in the list of prompts and parameters available for Action Buttons.
7. Enter the value for the Custom Parameter.
8. Enter a short description for the Custom Parameter.
9. Click Save.

Creating Prompts

You can create prompts that require the user to type in a value in a text field or to select one or more values from a list.

You can create prompts in the Change Report Properties dialog or in a filter when you specify a value. Creating prompts in the Change Report Properties dialog does not make them active in the report until they are used in a filter.

To create a new prompt:

   The Report Properties dialog displays.

1. In a report that you are editing, click Change Report Properties.
   The Report Properties dialog displays.
2. Click New.
   The Prompt and Parameter Creation and Edit dialog displays.
3. Enter a name for the parameter.
4. Select a data type for the value from the Parameter Type list.
5. Enter a description for the parameter. This only displays when the parameter is edited.
6. Click Use one of the values below (parameter).
7. Select a value to use in the parameter or enter a new value in the empty field.
8. Click OK.
   The parameter is created.
2. Click New.
   The Prompt and Parameter Creation and Edit dialog displays.

3. Enter a name for the prompt.

4. Select a data type for the value from the Parameter Type list.

5. Enter a description for the prompt. This does not display in the prompt message to the user.

6. Select Prompt the user to specify a value.

7. Click Next.
   The User Input Type page of the dialog displays.

8. Select a user input type.
   - Type in creates a field that the user must type the value in
   - Choose from a list of field values creates a list of choices that the user must select from

9. Enter text that displays on the prompt message in the Prompt message text field.
   This text will appear next to the list in the view if you choose Choose from a list of field values in the previous step.

10. Click Next.

11. Configure the Input Definition.
    If you selected the Type in user input type in the previous screen:
    1. Select a default value that can be a value that you supply, ALL, or NULL.
    2. Select User can leave value blank to allow this option.
       When using a Type in prompt, the user can type the following to indicate all, null, or blank values:
       - _ALL_ returns all values.
       - _NULL_ returns null values.
       - _BLANK_ returns blank values.
    3. Click Next.
    If you selected the Choose from a list of field values user input type in the previous screen:
    1. Select the data object from which to get the values.
       Click Change to select a data object. The fields in that data object will populate the Field list.
    2. Select a field from the Field list. The values in that field will populate the Values list
    3. Select Choose values if you want to exclude some of the values from the list. Then select the values that you want to appear in the prompt.
    4. Select a value and click Default Value to designate a starting value when the report is opened. A blue arrow will appear next to the default value.
    5. Select ALL, NULL, or BLANK to add any of these values to the list.
    6. Select User can leave value unselected or User can select multiple values to enable these options.
7. Click Next.
The Summary page of the dialog displays.

12. Review your selections and click Preview to view the prompt you created.
The Prompts dialog you created displays.

13. Click OK to close the Prompts dialog.

14. Click OK to close the Prompt and Parameter Creation and Edit dialog.
The prompt is listed in the Prompts and Parameters list. When this report is viewed, the prompt dialog displays and waits for user input before the report displays, unless a default value was selected.

Working with Prompts and Parameters

This section contains the following topics:

- Creating Prompts and Parameters
- Arranging Prompt Order
- Previewing Prompts
- Editing Prompts and Parameters
- Deleting Prompts and Parameters
- Cascading Prompts

You can work with prompts and parameters from the Report Properties dialog. Prompts and parameters created and edited from this dialog belong to all the views in the report. They must be applied in a filter at the view level to become active. Managing prompts and parameters from the Report Properties dialog means that you can make changes one time that might affect views in multiple areas.

Creating Prompts and Parameters

To create prompts and parameters:

1. In a report that you are creating or editing, click Change Report Properties.
The Report Properties dialog displays. The Prompts and Parameters tab is selected.

2. Click New.
The Prompt and Parameter dialog displays.

   To create a prompt, see "Creating Prompts" on page 7-2.

   To create a parameter, see "Creating Parameters" on page 7-1.

After prompts and parameters are created, they are listed in by name in the Report Properties dialog. The data type and default values display next to the prompt or parameter name. You can change the order that prompts display by arranging them in the list. The Arrange buttons and Preview buttons are disabled for parameters because they are not viewed by end users.

Arranging Prompt Order

To arrange the prompt order:
2. Click the **Arrange** arrows to move the prompt up or down in the list.

**Previewing Prompts**

To preview a prompt:
2. Click **Preview**.

   The prompt dialog displays.

**Editing Prompts and Parameters**

To edit a prompt or parameter:
1. Select the prompt or parameter to edit.
2. Click **Edit**.

   The Prompt and Parameter Creation and Edit dialog displays containing the specified fields.
3. Make changes as necessary and click **OK**.
4. All filters in the report using this prompt or parameter value are updated.

**Deleting Prompts and Parameters**

To delete a prompt or parameter:
1. Select the prompt or parameter to delete.
2. Click **Delete**.

   The prompt or parameter is deleted. Any filters in the report using this prompt or parameter are also removed from the view.

**Cascading Prompts**

You can create prompts that are dependent on input from other prompts by cascading them.

To cascade prompts:
1. Select a prompt and click **Cascade**.
2. Enter the prompt message text if you need to give instructions for the prompt.
3. Select the prompts in the cascade by selecting the checkboxes.
4. Arrange the prompts in the dependency order using the arrow buttons.

   Make sure that the order of cascading is relevant, that is, the first prompt should be a superset of the next one, and the next one should be the subset of the one before. Otherwise, the prompts will not work as expected if they are ordered incorrectly.
5. Click **OK**. The prompts will show their relationship in the Prompts and Parameters tab.
6. Click **OK** to close the Report Properties Dialog.
Using Parameters in Report URLs

You can specify values for prompts and parameters in the URL displaying a report. This can be used in a separate browser such as a web page in a portal site or as a link in an email. You can view the report and click Copy Shortcut to copy the URL for the report. Then you can add, remove, or change the values for the prompts and parameters.

The syntax includes:


  The URL to call the report and display it in Active Viewer. Copy this from the dialog displayed when you click Copy Shortcut.

- `&ReportParameters=(PromptorParameterName=(PromptorParameterValue);)`

  The section required to define the value for one prompt or parameter. You can customize this by providing other values for prompts or parameters.

You can define values for more than one prompt or parameter in any combination separated by semicolons. Prompts included in the report that do not have a value defined in the URL display to the user for input.

The following example shows the syntax used for a report containing a prompt and a parameter:

`http://host/oraclebam/3091/ActiveViewer/default.aspx?State=Start&Event=Initialize&NoWindow=True&ReportDef=1364&Buttons=False&ReportParameters=(BrandPrompt=(Fuji);StateParam=(California);)`

To set a prompt or parameter to all, null, or blank, you must use the following syntax to represent the values:

- `_ALL_` returns all values.
- `_NULL_` returns null values.
- `_BLANK_` returns blank values.

Driving Prompts and Parameters from Other Views

This section contains the following topics:

- Configuring Driving
- A Driving Example

Changing a view by making a selection in another view is called Driving. Driving enables you to use a selection in one view to drive a prompt or parameter in another view. For example you might use a column in a List view to drive a Bar Chart view showing a graphical view of a subset of the data in the list.

To drive a view it must have a prompt or parameter used in a filter. Also, drilling must not be enabled for driving to work. Drilling will override driving.

The view that drives the other views, the Driver, does not need to contain a prompt or parameter, but there is some configuration involved.

Driving is available in all List and Crosstab views.
Configuring Driving

To configure driving:

1. Create a parameter or prompt and use it in a filter in the target chart.
2. Edit the Driver view.
   
   Click the Properties button in the View Editor. To open the View Editor, double-click the view you are editing, or click Edit view in the View Tasks/Options list.

3. Select the Driving tab.

4. Select the prompt or parameter you created in step 1 for any column of data you want to use to drive views that are using that prompt or parameter in a filter.

5. To enable driving on more than one value select the Turn Multi-select On checkbox.
   
   Multi-select enables you to select multiple values in a column. Multi-select only works if you have a prompt that enables multiple values configured in the view it drives.

6. Click Apply or OK.

A Driving Example

The following is an example of driving a chart from a list view. This example uses the Call Center data object.

Step 1: Create a report with Streaming List and 3D Bar Chart views

1. In Active Studio, select the Home, My Reports, or Shared Reports tab.

2. Click Create a New Report.

3. Select a tiled report template with two view areas.

4. In the top view area select the Streaming List view.
   
   The View Editor opens.

5. In the View Editor, open the Samples folder and select the Call Center data object.

6. Click Next.

7. In the Data Fields selection screen, select all of the fields, and click Next.

8. Click Finish.

9. In the bottom view area select the 3D Bar Chart view.
   
   The View Editor opens.

10. In the View Editor, open the Samples folder and select the Call Center data object.

11. Click Next.

12. Select Description in the Group By list.

13. Select Quantity in the Chart Values list.

14. Verify that Sum is selected in the Summary Function list.

15. Click Next and click Finish.
Driving Prompts and Parameters from Other Views

Step 2: Create a filter with a prompt in the 3D Bar Chart view
1. In the report, select the 3D Bar Chart view, and click Edit view in the View Tasks/Options list.
   The View Editor opens.
2. Select the Filter tab.
3. Click add new entry.
4. Select Salesperson from the field list.
5. Select is equal to from the Comparison list.
6. Select Value.
7. Click Options and select *New Parameter/Prompt.
   The Prompt and Parameter Creation and Edit dialog opens.
8. Enter Salesperson in the Name field and click Next.
9. Enter Select a salesperson in the Prompt message text box and click Next.
10. Select Salesperson from the Field list.
11. Select the ALL checkbox.
12. Select ALL in the Values list and click Default Value.
   An arrow appears next to the ALL value in the list.
13. Select User can select multiple values and click Next.
14. Click OK.
   The Prompt and Parameter Creation and Edit dialog closes and the prompt expression appears in the Value field.
15. Click add entry in the Filter tab.
16. Click OK in the View Editor.
   The Prompts dialog opens.
17. Click OK.
   The 3D Bar Chart shows the quantity of each product description sold by all of the salespersons in the data object.

Step 3: Configure Driving in the Streaming List view
1. In the report, select the Streaming List view, and click Edit view in the View Tasks/Options list.
   The View Editor opens.
2. Click the Properties icon in the View Editor.
3. Select the Driving tab.
4. In the Map Fields to Prompts/Parameters list, select Salesperson in the list next to Salesperson.
5. Click OK.
   The View Editor closes.
Step 4: Save the report and test the driving
1. Click Save Report in the Actions list.
   The Save a Report dialog opens.
2. Select a name and location for the report and click OK.
3. Click View in the Actions list.
   The prompt dialog opens.
4. Click OK.
5. When the report is loaded, select Sue from the Salesperson column in the Streaming List view.
   The text color in the selected row changes so that you can see which Salesperson was selected. The bars in the Bar Chart view change to display the quantity of each product description sold by Sue.

Step 5: Configure Multi-select
Multi-select enables you to select more than one row in a list to drive the chart. Multi-select only works if you configured the prompt to allow the user select multiple values as described in "Step 2: Create a filter with a prompt in the 3D Bar Chart view".
1. Edit the Streaming List view.
2. Select the Driving tab in the View Editor.
3. Select Turn Multi-select On and click OK.
4. Save the report and view it.
5. When the report is loaded, select Sue from the Salesperson column in the Streaming List view.
   The text color in the selected row changes so that you can see which Salesperson was selected.
6. Select Mary from the Salesperson column in the Streaming List view.
   The text in Sue’s row stays colored, and the text in Mary’s row is colored also. The 3D Bar Chart shows the quantity of each product description sold by both Sue and Mary.
7. Select Mary again from the Salesperson column in the Streaming List view. The text color change is reversed, and the 3D Bar Chart shows Sue’s sales only.
This chapter discusses Action Buttons and how they are used in reports. This chapter contains the following topics:

- About Action Buttons
- Creating Action Buttons

About Action Buttons

Action Buttons let you manually take some action on data in a report. Action Buttons can appear in any report, but most of the actions you can define for Action Buttons only apply to the Action List view. In order to do some action with the selected data in an Action List you need to create Action Buttons.

Creating Action Buttons

This section provides information about creating Action Buttons. It contains the following topics:

- Creating Action Buttons
- Configuring Insert Action Types
- Configuring Constant Value Update Action Types
- Configuring Edit Column Update Action Types
- Configuring Delete Action Types
- Configuring Open a URL Action Types
- Configuring View a Report Action Types
- Configuring Reset a Form Action Types
- Configuring Refresh a View Action Types
- Configuring Show a Confirmation Message Action Types

Creating Action Buttons

To create an Action Button:

2. Select the Action List view in your report and click Change Report Properties in the Actions list.
The Report Properties dialog opens.

3. Select the **Action Buttons** tab.

4. Click **New**.

   The Action Button Creation and Edit dialog opens.

5. Enter a **Name** and **Description** for the Action Button.

   The text you enter in the Name field will be displayed as the button text in the report.

6. Select **Commit all actions in a single transaction** to have all of the actions configured in this Action Button take place as a single transaction.

7. Click **Next**.

8. Click **Add** to define an action for this Action Button.

   The Action Editor opens.

9. Select an **Action Type** from the list and click **Next**. Many action types only apply to Action List views as described in **Table 8–1**.

   **Table 8–1  Action Types**

<table>
<thead>
<tr>
<th>Action Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Inserts a row into the specified data object and populates the column values of that row according to the defined mappings</td>
</tr>
<tr>
<td>Constant Value Update</td>
<td>Updates fields in the selected rows of the specified Action List with the defined value (Action List only)</td>
</tr>
<tr>
<td>Edit Column Update</td>
<td>Commits all edits made in editable columns from the specified Action Lists (Action List only)</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes all selected rows for the specified Action List (Action List only)</td>
</tr>
<tr>
<td>Open a URL</td>
<td>Opens a URL in a new window. The URL is constructed by concatenating each of the specified terms.</td>
</tr>
<tr>
<td>View a Report</td>
<td>Opens a report and enables you to map values from the current report to parameters in the destination report.</td>
</tr>
<tr>
<td>Reset a Form</td>
<td>Clears any edits made to form inputs in the specified Action Form view or editable columns in the Action List view (Action Form and Action List only)</td>
</tr>
<tr>
<td>Refresh a View</td>
<td>Reloads the specified views</td>
</tr>
<tr>
<td>Show a confirmation message</td>
<td>Displays a confirmation message dialog before performing any of the other actions configured for this Action Button.</td>
</tr>
</tbody>
</table>

10. Define the action.

    See the action type configuration sections for more information:

    - "Configuring Insert Action Types" on page 8-3
    - "Configuring Constant Value Update Action Types" on page 8-4
    - "Configuring Edit Column Update Action Types" on page 8-5
    - "Configuring Delete Action Types" on page 8-5
    - "Configuring Open a URL Action Types" on page 8-5
    - "Configuring View a Report Action Types" on page 8-6
Creating Action Buttons

11. When you have finished adding actions, you can put them in order using the Arrange arrow buttons.

12. Click Next.

   - **Width. Auto fit** makes the button as wide as the button text or you can specify the width in pixels.
   - **Button Location.** Displays the button as part of the report or as part of a view.
     For Open a URL action types, when you display the button as part of a view you can alternatively choose to Display as a column of formatted links in the selected view. This option creates a hyperlink out of the values in the selected column instead of placing a button in the view. You can then choose to open a new window, replace the view, or replace the report when a user clicks the link.
   - **Alignment.** Displays the button at the top or bottom of the report or view.

14. Click OK to close the Action Button Creation and Edit dialog.

15. Click OK to close the Report Properties dialog.

   The Action Button will appear in the report.

**Configuring Insert Action Types**

The Insert action type enables you to insert a row into a target data object and populate the column values of that row according to the defined mappings.

To configure the Insert action type:

1. Select the Insert action type in the Action Editor.

2. Click Next.

3. Click Browse to select the target data object for the insert. The mappings table is populated with the columns and data types of the target data object.

4. Select a column and click Edit Mapping.

   The Value Mapping Creation and Edit dialog opens.

5. For each column, select a mapping type from the list.

   **Table 8–2 Mapping Types for Insert Action Type**

<table>
<thead>
<tr>
<th>Mapping Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No mapping is done between the current and target data objects.</td>
</tr>
<tr>
<td>Constant Value</td>
<td>A constant value will be inserted in the target data object. The specified value is validated against the data type of the column populated by this mapping. If you specify a string value for an integer column, an error message will occur.</td>
</tr>
</tbody>
</table>
Creating Action Buttons

8-4
Oracle Business Activity Monitoring Active Studio User's Guide

To populate the inserted row in the target data object with values, each column can be mapped to a different source of data.

If a column is mapped to None, null will be inserted for that column. If the column is non-nullable, the default value for the data type will be used. For example, if there is no mapping specified for a non-nullable integer column, zero (0) will be inserted. String is the only data type that does not have a default value. Therefore, if you attempt to insert null into a non-nullable string column, the action will fail.

6. Click Next.

7. Enter the definition for the type you selected.

8. Click OK to close the Value Mapping Creation and Edit dialog.

9. Edit the mappings for any of the other columns.

10. Click OK to close the Action Editor.

Configuring Constant Value Update Action Types

The Constant Value Update action type enables you to update fields in the selected rows of the specified Action List with a specified value. This action type is used in Action List views only.

To configure the Constant Value Update action type:

1. Select the Constant Value Update action type in the Action Editor.

2. Click Next.
4. Select a field in the Column list and enter a value in the Value field. Select Null if you want the value to be null.
5. Click OK to close the Action Editor.

Configuring Edit Column Update Action Types

The Edit Column Update action type commits all edits made in editable columns from the specified Action Lists. The user does not have to select the checkboxes to specify which rows should be updated. This action type is used in Action List views only.

To configure the Edit Column Update action type:
1. Select the Edit Column Update action type in the Action Editor.
2. Click Next.
3. Select one or more Action List views with editable columns.
4. Click OK to close the Action Editor.

Configuring Delete Action Types

The Delete action type deletes all selected rows in the specified Action List. This action type is used in Action List views only.

To configure the Delete action type:
1. Select the Delete action type in the Action Editor.
2. Click Next.
3. Select one or more Action List views.
   If only one Action List is selected, and there are no other actions defined for the Action Button, you will be given the choice to display the Action Button either as a regular button or a trashcan icon in the final step of the Action Button Creation and Edit dialog.
4. Click OK to close the Action Editor.

Configuring Open a URL Action Types

The Open a URL action type opens a URL in a new window. The URL is constructed by concatenating each of the specified terms.

To open a report URL, you should use the View a Report action described in "Configuring View a Report Action Types" on page 8-6.

To configure the Open a URL action type:
1. Select the Open a URL action type in the Action Editor.
2. Click Next.
3. Click New Term.
   The Value Mapping and Edit dialog opens.
4. Choose a mapping type to create a term.
Creating Action Buttons

5. Click Next.
6. Enter the definition for the type you selected.
7. Click OK to close the Value Mapping Creation and Edit dialog.
8. Select the Encode checkbox to encode the term.
9. Create more terms if necessary.
10. Select Click here to edit window features to change the browser window properties if necessary.
11. Enter a maximum number of windows to open.

When you use the Value from an Action List view mapping type and the user selects more than one row in the list, you can open a separate URL for every checked row in the Action List. The maximum specified here limits the total number of windows that can be opened at once. Opening too many windows at once can cause the client machine to malfunction.

12. Arrange the terms in the correct order using the Arrange arrow buttons.
13. Click OK to close the Action Editor.

Configuring View a Report Action Types

The View a Report action type opens a report and enables you to map values from the current report to parameters in the destination report.

To configure the View a Report action type:

1. Select the View a Report action type in the Action Editor.

<table>
<thead>
<tr>
<th>Mapping Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constant Value</td>
<td>A constant value will be inserted in the target data object. The specified value is validated against the data type of the column populated by this mapping. If you specify a string value for an integer column, an error message will occur.</td>
</tr>
<tr>
<td>Prompt/Parameter</td>
<td>The value held by the prompt or parameter is used as the value to insert in the target data object. It always retrieves the current value of a prompt or parameter even if it is changed by driving or surface prompts. To use this option the report must contain a prompt or parameter which is assigned to a filter in a view, or a custom parameter must be created in the Architect. See Chapter 7 for more information.</td>
</tr>
<tr>
<td>Client Cookie</td>
<td>The value of a cookie that resides on the client where this report will be viewed.</td>
</tr>
<tr>
<td>Unique button click ID</td>
<td>A unique ID number (randomly generated).</td>
</tr>
<tr>
<td>Value from a List view</td>
<td>A selected value in any List view. This is made possible when you elect to display a column as hyperlinks instead of creating a button for an action. See “Creating Action Buttons” on page 8-1, step 13. The Open a separate URL for each selected row option results in more than one URL opened in a separate browser window.</td>
</tr>
<tr>
<td>Value from an Action Form view</td>
<td>The value of the selected input field. Any inputs that have an rtsEnabledID attribute in the HTML will be represented in the list of values.</td>
</tr>
</tbody>
</table>
2. Click Next.
3. Click **Browse** to select the target report to open.
4. Define mappings for each parameter in the target report.
5. Select a parameter or prompt in the parameter column.
6. Click **Edit Mapping**. The Value Mapping Creation and Edit dialog opens.
7. Select a mapping type from the list

<table>
<thead>
<tr>
<th>Table 8–4 Mapping Types for View a Report Action Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mapping Type</strong></td>
</tr>
<tr>
<td>None</td>
</tr>
<tr>
<td>Constant Value</td>
</tr>
<tr>
<td>Prompt/Parameter</td>
</tr>
<tr>
<td>Client Cookie</td>
</tr>
<tr>
<td>Unique button click ID</td>
</tr>
<tr>
<td>Value from an ActionList view</td>
</tr>
<tr>
<td>Value from an ActionForm view</td>
</tr>
</tbody>
</table>

8. Click Next.
9. Enter the definition for the type you selected.
10. Click **OK** to close the Value Mapping Creation and Edit dialog.
11. Edit the mappings for any of the other parameters.
12. Select **Click here to edit window features** to change the browser window properties if necessary. This is the browser window that the target report will open in.
13. Enter a maximum number of browser windows that can open.
14. Click **OK** to close the Action Editor.

**Configuring Reset a Form Action Types**

The Reset a Form action type clears any edits made to form inputs in the specified Action Form view or editable columns in the Action List view.

To configure the Reset a Form action type:

1. Select the **Reset a Form** action type in the Action Editor.
2. Click Next.
3. Select one or more Action Form or Action List views.
4. Click OK to close the Action Editor.

Configuring Refresh a View Action Types

The Refresh a view action type reloads the specified views. This action is not needed for most views since they support active data and will automatically update when the data changes. This action is useful for views that do not support active data:

- External Content. This view can display any external URL, and it might be useful to supply a refresh button in the view if the content changes.
- Action List with editable columns. Action Lists do not support active data when one or more columns is editable, so it is useful to supply a refresh button to display any changes to the data.

To configure the Refresh a view action type:

1. Select the Refresh a view action type in the Action Editor.
2. Click Next.
3. Select one or more views.
4. Click OK to close the Action Editor.

Configuring Show a Confirmation Message Action Types

The Show a confirmation message action type displays a confirmation message dialog before performing any of the other actions configured for this Action Button.

To configure the Show a confirmation message action type:

1. Select the Show a confirmation message action type in the Action Editor.
2. Click Next.
3. Enter the text to display in the confirmation dialog.
4. Click OK to close the Action Editor.
Organizing and Sharing Reports

This chapter explains how to organize and share your reports.

This chapter contains the following topics:

- Organizing Your Reports
- Creating New Folders
- Setting Folder Permissions
- Working with Folders
- Copying Reports and Folders
- Moving Reports and Folders
- Sharing Reports with Other Users
- Deleting Shared Reports

Organizing Your Reports

You can organize reports by creating folders and moving reports into folders. You can also create copies of reports and share reports with other users. When you create a folder in the Shared Reports tab, you can assign permissions by associating users and actions with the folder.

Creating New Folders

You can create new folders for organizing your reports from the My Reports tab or the Shared Reports tab. Then you can copy or move reports into separate folders for different purposes or users.

After creating folders in the Shared Reports tab, you can set folder permissions to limit which users can view the reports it contains.

To create a new folder:

1. Click Create a new folder in the Organize list.
   A dialog for naming the new folder displays.
2. Type a name for the folder and click OK.
   The folder is created as a subfolder under My Reports or Shared Reports, based on where you created it.
You can create a hierarchy of folders within folders. The full folder path including the report name is limited to 255 characters. If you have many subfolder levels and long report names, you might encounter this limit.

**Setting Folder Permissions**

When you create folders in the Shared Reports tab or move folders to the Shared Reports tab, you can set permissions on the folder so that other users can view and access the reports contained in the folder. Permissions are unlimited on folders created in Shared Reports until you apply permissions for specific users. You do not need to set permissions on folders in the My Reports tab.

---

**Note:** Changes to permissions on folders and reports can take 20 minutes to propagate throughout the system.

---

To set permissions on a folder:

1. In the **Shared Reports** tab, click the folder to set permissions on.
2. Click **Folder Permissions** in the **Actions** list.
   
   The Folder Permissions dialog displays.
3. Click **Add user** or **Add group** to add users or groups.
   
   The Select Names dialog displays.
4. Click one or more users or groups to access to this folder, and click **OK**.
   
   The users are added to the list in the Folder Permissions dialog.
5. Select a user or group and check the permissions to assign. The options include:
   
   **View.** Can open and close folder, can view reports in this folder.
   
   **Create and View.** Can rename folders and reports, can edit folder permissions if folder owner, can copy folder and reports to other folders, can create folders and reports and save them in this folder.
   
   **Create, View, and Delete.** Can delete folders and reports in this folder, can move folders and reports to other folders.

   If you have more than one user in the list, you must select each one individually and assign permissions. Different users might have different permissions on the same folder.
6. Click **OK** to save your changes.

Reports placed directly in Shared Reports have open permissions. Only place reports there if you want all users to see them.

To delete a user from a folder permissions list:

1. In the **Shared Reports** tab, click the folder to change permissions on.
2. Click **Folder Permissions** in the **Actions** list.
   
   The Folder Permissions dialog displays.
3. Click a user and click **Delete**.
   
   The user is deleted from the list.
4. Click **OK** to save your changes.
Working with Folders

When you select a folder on the My Reports tab or Shared Reports tab, the actions for working with folders display in the Actions list. You must have certain folder permissions to perform folder tasks.

To open a folder:
1. Click the folder to open.
2. Click **Open Folder** in the **Actions** list. You can also double-click a folder to open it.

   The folder is opened, and the contents of the folder displays.

To rename a folder:
1. Click the folder to rename.
2. Click **Rename Folder** in the **Actions** list.
3. Type a new name and click **OK**.

   The folder is renamed. You must assign unique folder names within a containing folder.

To close a folder:
- Click **Close Folder** in the **Actions** list.

   The current folder is closed, and the contents of the containing folder displays.

To delete a folder:
1. Click the folder to delete.
2. Click **Delete Folder** in the **Actions** list.

   The folder is deleted.

To navigate folders do any of the following:
- Double-click a folder to open it.
- Click **Close Folder** in the **Actions** list to view the containing folder.
- Click the **Folder** drop down list in the toolbar and select a containing folder more than one level up.

Copying Reports and Folders

You can copy reports into other folders within My Reports or to a folder in Shared Reports. Copying reports does not move the original report. Report names in the folders you copy to must be unique. You must have certain folder permissions to perform folder tasks.

To copy a report to another folder:
1. Select the report to copy in the **My Reports** tab or the **Shared Reports** tab.
2. Click **Copy to** in the **Organize** list.

   A dialog showing the folder structure displays.
3. Click a folder to copy the report to.
4. Click **Copy**.

   A message displays to confirm that the report was copied.
Moving Reports and Folders

You can move reports into folders within My Reports or to a folder in Shared Reports. Moving reports moves the original report. Report names in the folders you move to must be unique. You must have certain folder permissions to perform folder tasks.

To move a report to another folder:
1. Select the report to move in the My Reports tab or the Shared Reports tab.
2. Click Move to in the Organize list.
   A dialog showing the folder structure displays.
3. Click a folder to copy the report to.
4. Click Move.
   A message displays to confirm that the report was copied.

You can move folders into other folders in the same way.

Sharing Reports with Other Users

Reports that other users share with you display in folders on the Shared Reports tab. Depending on the rights assigned with the shared subfolder, you can view, create, edit, or delete shared reports.

After creating reports, you can choose users to share your reports with by moving the reports into shared subfolders and assigning users and permissions to the folder.

---

**Note:** Changes to permissions on folders and reports can take 20 minutes to propagate throughout the system.

---

To share a report:
1. Copy or move the report into a folder in the Shared Reports tab.
2. Assign permissions to users that you want to have access to the folder. A user must have the permission to view the contents of the folder to see the reports it contains.

Deleting Shared Reports

You can stop sharing reports with other users by either removing their permissions to the folder or by moving or deleting specific reports. You can also move or delete the entire folder.

When you remove folder permissions or remove shared reports or folders, any alerts that a user created based on the report in that shared location will be disabled.
This chapter explains how to personalize your report viewing experience. This chapter contains the following topics:

- Specifying Report Loading Indicator Settings
- Specifying Printing Options
- Specifying Alert Delivery Settings
- Selecting a Report for the Home Tab

You can personalize settings in the Personalize dialog, such as printing options, reports for the Home tab, and alert delivery settings. For printing options, you can set your default page orientation and paper size. You can define where your alerts are delivered and the order of delivery. You can choose what to view on the Home tab when you first display it.

### Specifying Report Loading Indicator Settings

In the Personalize dialog, you can enable or disable the loading indicator. The report loading indicator is a moving icon to let you know that data is still loading.

To specify the report on the Home tab:

1. Click the **Personalize** link in the upper right corner of the Active Studio window. The Personalize dialog displays.
2. On the **General** tab, do one of the following:
   - **Click Use default setting specified by your administrator** to accept the setting from the administrator. The indicator might or might not display when using this setting.
   - **Click Always display the Report Loading Indicator** to view the indicator for every report.
   - **Click Never display the Report Loading Indicator** if you do not want view the indicator when a report is loading.
3. Click **OK** to save your settings.

### Specifying Printing Options

You can specify default printing options from the Personalize dialog.

To specify printing options:
1. Click the Personalize link in the upper right corner of the Active Studio window. The Personalize dialog displays.
2. Click the Print Setup tab.
3. Click either Portrait or Landscape to define the page orientation.
4. Select a paper size from the list.
5. Click OK to save your settings.

Specifying Alert Delivery Settings

You specify where you want alerts to be sent in the Personalize dialog.
To specify alert delivery settings:
1. Click the Personalize link in the upper right corner of the Active Studio window. The Personalize dialog displays.
2. Select the Alert Settings tab.
3. Enter your e-mail address for your e-mail account. You can enter multiple e-mail addresses separated by commas. If you enter multiple addresses, they will all receive your e-mail alerts.
4. Click OK to save your settings.

Selecting a Report for the Home Tab

In the Personalize dialog, you can specify the report you view on the Home tab.
To specify the report on the Home tab:
1. Click the Personalize link in the upper right corner of the Active Studio window. The Personalize dialog displays.
2. Click the Home tab.
3. Do one of the following:
   ■ Click Report last viewed to always display the most recently viewed report.
   ■ Click the Select Report button and select a report to display on the Home tab.
   ■ Click No Report if you do not want a report to automatically display on the Home tab.
4. Click OK to save your settings.
Glossary

**action**
Includes all of the things you can do with reports, folders, and alerts. Examples of actions include creating, viewing and editing reports and alerts.

**Active Data Cache (ADC)**
The Active Data Cache is designed and optimized to handle large amounts of data in a real-time solution. To make data readily accessible and deliverable, it keeps data persistent in memory. The data feed to the Active Data Cache is a combination of business data sources, from data warehouse information to transactional feeds and other enterprise sources.

**Active Studio**
Active Studio is the thin user interface for the power user. Using Active Studio, the power user can create and edit reports. Reports can be shared with other users and rules can be created for determining the scheduling and delivery of the reports. Report types include columnar reports, crosstabs, KPIs, charts, spreadsheets, and more.

**Active Viewer**
Active Viewer is the thin user interface for the business user. When new information is available, the user receives an instant message that contains a link to the information. The user opens Active Viewer through this link and a report is displayed. The Pro version includes dynamic group collaboration using pen annotation.

**Administrator**
Administrator is the thin user interface for the system administrator who is responsible for user management and overall server management. Using Administrator, the system administrator manages users and security levels, monitors loading to the Active Data Cache, and configures Oracle Business Activity Monitoring services.

**alert**
Based on rules and events occurring in real-time, alerts are delivered through instant messaging technology. Alerts can be created in Active Studio and Architect.

**Architect**
Architect is the thin user interface for the data designer. Using Architect, the data designer creates and manages data objects in the Active Data Cache and manages real-time message processing.
crosstab
A Crosstab view is a spreadsheet format that combines rows and columns to display a multi-dimensional view of values. A Crosstab is summarized vertically and horizontally for a column or row that is added. Summary function that you can add to Crosstabs include sum, average, count, minimum (min) or maximum (max).

Data Flow Service
Runs Plans and retrieves Plan information from data sources.

data flow
The graphical display of the steps in a Plan viewed in the Data Flow Editor. A complete data flow includes at least one data source and at least one sink.

data object
Contains the information set to display in each view of a report. Data objects are created and maintained through Architect in the ADC.

distribution list
The system administrator can create distribution lists of users which are used to send reports or alerts to groups of users.

Enterprise Link
Enterprise Link connects Oracle Business Activity Monitoring to other information sources such as database servers, flat files, and XML sources. By integrating with middle ware applications to create connections to enterprise application message queues, Enterprise Link deciphers the significant messages and filters out unwanted information.

enterprise message source
Providers of the real-time information flowing through the enterprise to the ADC. Each enterprise message source connects to a specific message queue and the information is delivered into a data object in the ADC.

folder permissions
Report designers can choose how to share reports contained in the folder with other Active Studio users by assigning folder-level permissions. Folder permissions include View, Create, and Delete.

Home tab
The starting point for viewing recent and new reports in Active Studio.

KPI
Graphical key performance indicators such as an arrow to indicate whether a stock symbol's value went up or down.

Message Center
Tracks the presence of users so that reports and alerts are reliably received. Messages and reports are delivered using e-mail.

My Reports tab
You can view and edit reports you create and own on the My Reports tab in Active Studio.
Plan
Contain steps called Transforms that are linked together to create powerful data flows through Enterprise Link Design Studio. Plans contain instructions for locating data sources, data manipulation, and data loading to the ADC.

report
Display real-time or point-in-time information in multiple views such as lists, columnar reports, charts, key performance indicators (KPIs), crosstabs, or spreadsheets. Report designers can add formatting and data modifiers including filtering, sorting, calculations, grouping, and summaries.

role
A set of permissions that can be assigned to a domain group through Administrator. By adding groups of users to roles, the system administrator defines the level of user access to Oracle Business Activity Monitoring applications and items.

Shared Reports tab
You can view reports that other users shared with you on the Shared Reports tab in Active Studio. You have access to view these reports, but because you might not have Create or Delete permissions for them, you cannot always edit and delete them.

Transform
The building blocks of a Plan. Each Transform performs specialized operations and functions as either a source, data manipulation, data flow control, or sink Transform.

user
Login accounts that have access to Oracle Business Activity Monitoring applications and items. Users are managed through Administrator.

view
A report can contain a single view or multiple tiled views. View types include lists, columnar reports, charts, key performance indicators (KPIs), crosstabs, or spreadsheets.
### A
- Accessing Active Studio, 1-2
- Action buttons, 3-4
  - Configuring
    - Constant value update types, 8-4
    - Delete types, 8-5
    - Edit column update types, 8-5
    - Insert types, 8-3
    - Open a URL types, 8-5
    - Refresh a view types, 8-8
    - Reset a form types, 8-7
    - Show a confirmation message types, 8-8
    - View a report types, 8-6
  - Creating, 8-1
  - Overview, 8-1
- Action form
  - Overview, 3-21
- Action form views
  - Creating, 3-22
  - Example, 3-22
  - Templates, 3-21
- Action list view, 3-4
- Actions in Active Studio interface, 1-3
- Actions, in alerts, 6-3
- Active data
  - Retrieval interval, 2-12
  - Starting and stopping, 2-3
- Active data architecture, 1-5
- Active Data Cache, 1-6
- Active data formatting, 4-24
- Active Studio, 1-6
  - Accessing, 1-2
  - Starting, 1-2
- Active Studio interface, 1-1
  - Actions, 1-3
  - Alerts, 1-3
  - Folders, 1-3
  - Guide text, 1-4
  - Personalizing, 1-5
  - Reports, 1-3
  - Tabs, 1-3
  - Toolbars, 1-3
  - View Editor, 1-4
  - View Tasks/Options list, 1-4
- Active Studio overview, 1-1

### B
- Background color, 2-9
- Background image, 2-9
- Borders and shading in views, 4-20
- Browser settings, 1-6
- Buttons in action lists, 3-4
- Buttons, action
  - Configuring
    - Constant value update types, 8-4
    - Delete types, 8-5
    - Edit column update types, 8-5
    - Insert types, 8-3
    - Open a URL types, 8-5
    - Refresh a view types, 8-8
    - Reset a form types, 8-7
    - Show a confirmation message types, 8-8
    - View a report types, 8-6
  - Creating, 8-1
  - Overview, 8-1
- Alert rules, 6-1
- Alerts, 1-5
  - Actions, 6-3
  - Activating, 6-6
  - Building rules, 6-1
  - Conditions, 6-3
  - Creating from templates, 6-4
  - Deleting, 6-7
  - Delivery settings, 10-2
  - Dependent rules, 6-5
  - Events, 6-2
  - Frequency constraints, 6-4
  - History, 6-6
  - Launching by URL, 6-7
  - Messages, 6-4
  - Options, 6-2
  - Overview, 6-1
- Alerts in Active Studio interface, 1-3
- Aligning text in views, 4-21
- Architect, 1-6
- Axis properties in views, 4-20
calculations
aggregate functions, 4-10
datetime functions, 4-10
expressions, 4-10
special characters, 4-18
string functions, 4-10
using HTML, 4-18
calculations in views, 4-9
cascading prompts, 7-5
changing view types, 2-11
chart views
creating, 3-5
general properties, 3-6
multiple data objects, 3-10
pie chart, 3-7
statistical process control, 3-7
chart views overview, 3-4
columnar reports
inserting text, 5-3
column group view, 3-25
columnar report
creating, 2-5
overview, 2-10
summary functions, 2-6
columnar views, 3-10
general properties, 3-11
summaries, 3-11
components of Oracle Business Activity Monitoring, 1-5
conditions, in alerts, 6-3
container views, 3-25
continuous time series, 3-9
copying report URLs, 2-13
creating and delivering reports, 1-5
crosstab views
filtering, 3-16
general properties, 3-16
overview, 3-14
pivoting, 3-17
rolling up and drilling down, 3-17
summaries, 3-15
using, 3-16
custom parameters, 7-2
dashboard view, 3-26
data filtering, 4-1
data labels in views, 4-22
data object
replacing in a view, 2-11
data objects, using multiple in a chart, 3-10
datetime functions in calculations, 4-10
deleting alerts, 6-7
deleting reports, 2-14
deleting views, 2-11
drilling
across views
drilling across, 4-6
down, 4-5
hierarchies, 4-6
overview, 4-5
targets, 4-7
through, 4-6
to URLs, 4-8
up, 4-6
drilling down
crosstab view, 3-17
summary crosstab view, 3-18
driving
configuration, 7-7
driving example, 7-7
driving prompts and parameters, 7-6
editing reports, 2-8
e-mailing reports, 2-13
Enterprise Link, 1-6
Event Engine, 1-6
events, in alerts, 6-2
examples
action form template, 3-22
driving, 7-7
Excel views, 3-19
performance tips, 3-20
using, 3-20
expressions in calculations, 4-10
external content views, 3-23
creating, 3-23
features of Oracle Business Activity Monitoring, 1-5
filtering
crosstab view, 3-16
summary crosstab view, 3-17
filtering data in views, 4-1
folders
copying, 9-3
moving, 9-4
reports
managing, 9-3
permissions, 9-2
folders in Active Studio interface, 1-3
folders, for reports, 9-1
font formatting in views, 4-22
formatting report titles, 2-9
formatting views, overview, 4-1
frequency constraints for alerts, 6-4
Index-3

G
general properties in views, 4-19
grouping items in a columnar report, 2-5
groups, time, 3-9
guide text in Active Studio interface, 1-4

H
hierarchies in drilling, 4-6
home tab, setting defaults, 10-2
HTML in calculations, 4-18

I
images in columnar reports, 5-2
inserting views, 2-10
interface, Active Studio, 1-1
Internet Explorer settings, 1-6

K
key market indicator views, 3-11
general properties, 3-13

L
labels in views, 4-22
list view general properties, 3-2
list views
creating, 3-2
overview, 3-1
sorting, 3-3

M
matrix views
using, 3-18
messages in alerts, 6-4

O
offline, saving reports, 2-14
overview of Active Studio, 1-1

P
parameters
creating, 7-1, 7-4
custom, 7-2
deleting, 7-5
driving, 7-6
driving example, 7-7
editing, 7-5
in report URLs, 7-6
overview, 7-1
personalizing Active Studio, 1-5
pie chart, 3-7
pivoting
crosstab view, 3-17
popup blockers, 1-6
printing options, 10-1
printing reports, 2-12
prompts
cascading, 7-5
creating, 7-2, 7-4
deleting, 7-5
driving, 7-6
driving example, 7-7
editing, 7-5
ordering, 7-4
overview, 7-1
previewing, 7-5

R
renaming reports, 2-7
report creation and delivery, 1-5
reports
adding titles, 2-9
background color or image, 2-9
columnar
creating, 2-4
toolbars, 5-1
columnar, overview, 5-1
copying, 9-3
creating, 2-3
deleting, 2-14
deleting shared, 9-4
editing, 2-8
e-mailing, 2-13
folders
creating, 9-1
managing, 9-3
permissions, 9-2
formatting titles, 2-9
home tab defaults, 10-2
loading indicator settings, 10-1
moving, 9-4
organizing, 9-1
printing, 2-12
printing options, 10-1
renaming, 2-7
saving, 2-7
saving offline, 2-7, 2-14
sharing, 9-4
URLs, 2-13
viewing, 2-1

Reports Engine, 1-6
reports in Active Studio interface, 1-3
resizing views, 2-10
rolling up
crosstab view, 3-17
summary crosstab view, 3-18
row group view, 3-25
rules, building for alerts, 6-1

S
saving offline, 2-7
saving offline reports, 2-14
saving reports, 2-7

Index-3
shading and borders in views, 4-20
Shared Reports tab, 1-5
sorting
  lists, 3-3
  summary crosstab, 3-18
special characters in calculations, 4-18
spreadsheet views
  using, 3-20
statistical process control charts, 3-7
string functions in calculations, 4-10
summaries in columnar views, 3-11
summaries in crosstab views, 3-15
summaries, in collapsed list view, 3-3
summary crosstab view, using, 3-17
summary crosstab views
  filtering, 3-17
  rolling up and drilling down, 3-18
  sorting, 3-18
  summaries, 3-15
summary functions
  in a columnar report, 2-6
surface prompts views, 3-24
surface prompts, creating, 4-19

tab group view, 3-26
tabs
  Shared Reports, 1-5
tabs in Active Studio interface, 1-3
targets, drill across, 4-7
templates
  alerts, 6-4
templates in action form views, 3-21
text alignment in views, 4-21
text, inserting in columnar reports, 5-3
themes in views, 4-19
tiled reports, creating, 2-3
time groups, 3-9
titles, formatting, 2-9
titles, in reports, 2-9
toolbars
  columnar reports, 5-1
  in columnar reports, 2-6
toolbars in Active Studio interface, 1-3
top N data, 4-4

URLs
  alerts, 6-7
  parameters in, 7-6
URLs for reports, 2-13
URLs, drilling to, 4-8
utility views, 3-24

value formatting in views, 4-23
View Editor, 2-8
view editor
lists, 3-1
  sorting, 3-3
matrix, 3-18
resizing, 2-10
row group, 3-25
spreadsheet, 3-18
  using, 3-20
summary crosstab
  filtering, 3-17
  rolling up and drilling down, 3-18
  sorting, 3-18
  summaries, 3-15
  using, 3-17
surface prompts, 3-24
tab group, 3-26
text alignment, 4-21
themes, 4-22
top N data, 4-4
utility, 3-24
value formatting, 4-23